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Product notice

This user guide describes features that are 
common to most models. Some features may 
not be available on your computer.

Not all features are available in all editions of 
Windows. This computer may require upgraded 
and/or separately purchased hardware, drivers 
and/or software to take full advantage of 
Windows functionality. Go to 
http://www.microsoft.com for details.

Software terms

By installing, copying, downloading, or 
otherwise using any software product 
preinstalled on this computer, you agree to be 
bound by the terms of the HP End User License 
Agreement (EULA). If you do not accept these 
license terms, your sole remedy is to return the 
entire unused product (hardware and software) 
within 14 days for a full refund subject to the 
refund policy of your seller.

For any further information or to request a full 
refund of the price of the computer, please 
contact your seller.

http://www.microsoft.com


Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not place 
the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat surface. Do 
not allow another hard surface, such as an adjoining optional printer, or a soft surface, such as pillows or rugs 
or clothing, to block airflow. Also, do not allow the AC adapter to contact the skin or a soft surface, such as 
pillows or rugs or clothing, during operation. The device and the AC adapter comply with the user-accessible 
surface temperature limits defined by the International Standard for Safety of Information Technology 
Equipment (IEC 60950).
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1 Product features

Standard configuration features
Features may vary depending on the model. For support assistance and to learn more about the hardware 
and software installed on your computer model, run the HP Support Assistant utility.

NOTE: This computer model can be used in a tower orientation or a desktop orientation.
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Front panel components
Drive configuration may vary by model. Some models have a bezel blank covering the slim optical drive bay.

1 Slim Optical Drive (optional) 6 Headphone Connector

2 USB 2.0 Charging (powered) Port (black) 7 Dual-State Power Button

3 USB 2.0 Port (black) 8 Hard Drive Activity Light

4 USB 3.0 Ports (blue) 9 SD Card Reader (optional)

5 Microphone/Headphone Connector   

NOTE: When a device is plugged into the Microphone/Headphone Connector, a dialog box will pop up asking if you want to 
use the connector for a microphone line-In device or a headphone. You can reconfigure the connector at any time by 
double-clicking the Audio Manager icon in the Windows taskbar.

NOTE: The USB 2.0 Charging Port also provides current to charge a device such as a Smart Phone. The charging current is 
available whenever the power cord is plugged into the system, even when the system is off.

NOTE: The Power On Light is normally white when the power is on. If it is flashing red, there is a problem with the 
computer and it is displaying a diagnostic code.
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Rear panel components

1 PS/2 Mouse Connector (green) 7 PS/2 Keyboard Connector (purple)

2 Serial Connector 8 DisplayPort Monitor Connectors

3 RJ-45 Network Connector 9 VGA Monitor Connector

4 USB 2.0 Ports with Wake from S4 feature (black) 10 USB 3.0 Ports (blue)

5 Line-In Audio Connector (blue) 11 USB 2.0 Ports (black)

6  Power Cord Connector 12 Line-Out Connector for powered audio 
devices (green)

NOTE: An optional second serial port and an optional parallel port are available from HP.

If using a USB keyboard, HP recommends connecting the keyboard to one of the USB 2.0 ports with the wake from S4 feature. 
The wake from S4 feature is also supported on the PS/2 connectors if enabled in BIOS F10 Setup.

When a device is plugged into the blue Line-In Audio Connector, a dialog box will pop up asking if you want to use the 
connector for a line-in device or a microphone. You can reconfigure the connector at any time by double-clicking the Audio 
Manager icon in the Windows taskbar.

When a graphics card is installed in one of the system board slots, the video connectors on the graphics card and the 
integrated graphics on the system board may be used at the same time. However, for such a configuration, only the display 
connected to the discrete graphics card will display POST messages.

The system board graphics can be disabled by changing settings in Computer Setup.

Rear panel components 3



Serial number location
Each computer has a unique serial number and a product ID number that are located on the exterior of the 
computer. Keep these numbers available for use when contacting customer service for assistance.
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2 Illustrated parts catalog

Small Form Factor (SFF) chassis spare parts

Computer major components

NOTE: HP continually improves and changes product parts. For complete and current information on 
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then 
follow the on-screen instructions.

Item Description

(1) Access panel

(2) Front bezel

* Bezel blank

(3) System board (includes replacement thermal material)

Small Form Factor (SFF) chassis spare parts 5
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Item Description

(4) Power supply

 200W, 92% efficient

 200W, 85% efficient

 200W, standard

(5) Fan sink (includes replacement thermal material)

 Memory modules (PC3-12800, 1600-MHz)

 8-GB

 4-GB

 2-GB

 Processors (include replacement thermal material)

 AMD A10-8850B, 3.9 GHz

 AMD A10-8750B, 3.6 GHz

 AMD A10-7800B, 3.57 GHz

 AMD A8-8650B, 3.2 GHz

 AMD A8-7600B, 3.1 GHz

 AMD A6-8550B, 3.7 GHz

 AMD A6-8350B, 3.5 GHz

 AMD A4-7300B, 3.8 GHz

6 Chapter 2   Illustrated parts catalog



Misc parts

Item Description

(1) Fan baffle

(2) Rear baffle

(3) Solenoid lock

(4) Front I/O assembly

(5) Speaker

(6) Power switch

(7) SATA drive power cable

(8) SATA data cable, 14 inch, 1 straight end, 1 angled end

(9) Printer port, PCI card

(10) nVIDIA GT730 Grayling 2 GB DDR3 PCIex8

(11) Serial port, PCI card
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Item Description

* Chassis stand

* Center strip kit

* M.2 USB cable

* SATA SS power extension, 20 inch cable

* Slim optical drive bezel blank

* Hard drive conversion bracket, 2.5-inch to 3.5-inch

* Hood sensor

* HP Business PC Security Lock

* Rubber foot

* Secure Digital (SD) card reader

* Keyed cable lock

* Grommet, hard drive isolation, blue

* DisplayPort cable

* USB 3.1 Type Cx1 PCIe x1 card

* PCIe to M.2 adapter

* WLAN module caddy card + Bluetooth

* Wireless antenna for use with WLAN modules

* Adapters

 2.5-inch for card reader

 DisplayPort to HDMI 1.4

 DisplayPort to VGA

 DisplayPort to DVI

 DVI to VGA

 DVI-I to VGA

 USB-C to USB 3.0

* Mouse

 PS2, optical

 USB, laser

 USB, optical

 Antimicrobial

 Washable

 Wireless

 HP USB Hardened

* Keyboards
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Item Description

 PS/2

 PS/2 slim

 USB

 HP USB slim

 HP USB Conferencing

 Wireless keyboard, mouse, and dongle

 USB/PS2 Washable

 Smart card

Drives

Description

Hard drives/Solid-state drives

2-TB, 7200-rpm

1-TB, 7200-rpm, 3.5-inch

1-TB, 7200-rpm, 2.5-inch

1-TB, hybrid SSD, 3.5-inch or 2.5-inch

500-GB, 7200-rpm, 2.5-inch, SED

500 GB, 7200 rpm, 3.5-inch or 2.5-inch

500-GB, 7200-rpm, 2.5-inch, OPAL2, self-encrypting drive (SED)

500-GB, 5400-rpm, 2.5-inch, FIPS

500-GB, hybrid SSD, 2.5-inch or 2.5-inch

500-GB, 5400-rpm, 2.5-inch, 5 mm

512 GB Solid-state Drive (SSD)

512-GB Solid-state Drive (SSD), M.2, 2280SS, PCIe

256-GB Solid-state Drive (SSD), self-encrypting (SED)

256-GB Solid-state Drive (SSD)

256-GB Solid-state Drive (SSD), TLC

256-GB Solid-state Drive (SSD), M.2, 2280SS, PCIe

180 GB Solid-state Drive (SSD)

180 GB Solid-state Drive (SSD), OPAL2, MLC

128-GB Solid-state Drive (SSD), self-encrypting drive (SED)

128-GB Solid-state Drive (SSD)

128-GB Solid-state Drive (SSD), TLC
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Description

128-GB Solid-state Drive (SSD), M.2, 2280SS, PCIe

120-GB Solid-state Drive (SSD)

120-GB Solid-state Drive (SSD), OPAL2, MLC

Optical drives

Blu-ray BD-Writer XL Drive

DVD±RW drive

DVD-ROM drive

Grommet, hard drive isolation, blue
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3 Routine care, SATA drive guidelines, and 
disassembly preparation

This chapter provides general service information for the computer. Adherence to the procedures and 
precautions described in this chapter is essential for proper service.

CAUTION: When the computer is plugged into an AC power source, voltage is always applied to the system 
board. You must disconnect the power cord from the power source before opening the computer to prevent 
system board or component damage. 

Electrostatic discharge information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive 
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic device 
exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work perfectly 
throughout a normal cycle. The device may function normally for a while, but it has been degraded in the 
internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge 
contains enough power to alter device parameters or melt silicon junctions.

Generating static

The following table shows that:

● Different activities generate different amounts of static electricity.

● Static electricity increases as humidity decreases.

 Relative Humidity

Event 55% 40% 10%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

Removing DIPs from plastic tube

7,500 V

3,000 V

400 V

400 V

15,000 V

5,000 V

800 V

700 V

35,000 V

12,000 V

6,000 V

2,000 V

Removing DIPs from vinyl tray

Removing DIPs from Styrofoam

Removing bubble pack from PCB

Packing PCBs in foam-lined box

2,000 V

3,500 V

7,000 V

5,000 V

4,000 V

5,000 V

20,000 V

11,000 V

11,500 V

14,500 V

26,500 V

21,000 V

These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

NOTE: 700 volts can degrade a product.
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Preventing electrostatic damage to equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree of 
sensitivity. The following packaging and grounding precautions are necessary to prevent damage to electric 
components and accessories.

● To avoid hand contact, transport products in static-safe containers such as tubes, bags, or boxes.

● Protect all electrostatic parts and assemblies with conductive or approved containers or packaging.

● Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from their container.

● Always be properly grounded when touching a sensitive component or assembly.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive 
foam.

Personal grounding methods and equipment

Use the following equipment to prevent static electricity damage to equipment:

● Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground cords. 
To provide proper ground, a strap must be worn snug against bare skin. The ground cord must be 
connected and fit snugly into the banana plug connector on the grounding mat or workstation.

● Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible with 
most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both feet with 
a maximum of one-megohm ± 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage

Antistatic plastic

Carbon-loaded plastic

Metallized laminate

1,500

7,500

15,000

Grounding the work area

To prevent static damage at the work area, use the following precautions:

● Cover the work surface with approved static-dissipative material. Provide a wrist strap connected to the 
work surface and properly grounded tools and equipment.

● Use static-dissipative mats, foot straps, or air ionizers to give added protection.

● Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate. Handle 
them only at static-free work areas.

● Turn off power and input signals before inserting and removing connectors or test equipment.

● Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

● Keep work area free of nonconductive materials such as ordinary plastic assembly aids and Styrofoam.

● Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.
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Recommended materials and equipment

Materials and equipment that are recommended for use in preventing static electricity include:

● Antistatic tape

● Antistatic smocks, aprons, or sleeve protectors

● Conductive bins and other assembly or soldering aids

● Conductive foam

● Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

● Static-dissipative table or floor mats with hard tie to ground

● Field service kits

● Static awareness labels

● Wrist straps and footwear straps providing one-megohm +/- 10% resistance

● Material handling packages

● Conductive plastic bags

● Conductive plastic tubes

● Conductive tote boxes

● Opaque shielding bags

● Transparent metallized shielding bags

● Transparent shielding tubes

Operating guidelines
To prevent overheating and to help prolong the life of the computer:

● Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and cold.

● Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all vented sides 
of the computer and above the monitor to permit the required airflow.

● Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the 
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also 
restricts airflow.

● Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign matter 
can block the vents and limit the airflow. Be sure to unplug the computer before cleaning the air vents.

● Never operate the computer with the cover or side panel removed.

● Do not stack computers on top of each other or place computers so near each other that they are subject 
to each other’s re-circulated or preheated air.

● If the computer is to be operated within a separate enclosure, intake and exhaust ventilation must be 
provided on the enclosure, and the same operating guidelines listed above will still apply.

● Keep liquids away from the computer and keyboard.
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● Never cover the ventilation slots on the monitor with any type of material.

● Install or enable power management functions of the operating system or other software, including 
sleep states.

Routine care

General cleaning safety precautions

1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and then use 
the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.

4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.

5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case

Follow all safety precautions in General cleaning safety precautions on page 14 before cleaning the computer.

To clean the computer case, follow the procedures described below:

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with a cloth 
or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will evaporate 
quickly and not leave a residue.

● After cleaning, always wipe the unit with a clean, lint-free cloth.

● Occasionally clean the air vents on the computer. Lint and other foreign matter can block the vents and 
limit the airflow.

Cleaning the keyboard

Follow all safety precautions in General cleaning safety precautions on page 14 before cleaning the keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the Computer 
Case on page 14.

When cleaning debris from under the keys, review all rules in General cleaning safety precautions on page 14 
before following these procedures:

CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under the 
keys. 

● Visible debris underneath or between the keys may be removed by vacuuming or shaking.

● Canned, pressurized air may be used to clean debris from under the keys. Caution should be used as too 
much air pressure can dislodge lubricants applied under the wide keys.
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● If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool is 
available through many electronic supply outlets.

CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys are 
improperly removed or installed, the keyboard may not function properly.

● Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed out. Be 
careful not to wipe away lubricants necessary for proper key functions. Use tweezers to remove any 
fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the monitor

● Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for 
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into the 
housing and damage a component. Never use solvents or flammable liquids on the monitor.

● To clean the monitor body follow the procedures in Cleaning the Computer Case on page 14.

Cleaning the mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

● Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out any 
debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

● To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 14.

Service considerations
Listed below are some of the considerations that you should keep in mind during the disassembly and 
assembly of the computer.

Power supply fan

The power supply fan is a variable-speed fan based on the temperature in the power supply.

CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is off when 
the computer is in “Standby,” “Suspend,” or “Off” modes. 

You must disconnect the power cord from the power source before opening the computer to prevent system 
board or component damage.

Tools and software Requirements

To service the computer, you need the following:

● Torx T-15 screwdriver

● Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

● Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

● Phillips #2 screwdriver

● Diagnostics software

● Tamper-resistant T-15 wrench

Service considerations 15



Screws

The screws used in the computer are not interchangeable. They may have standard or metric threads and may 
be of different lengths. If an incorrect screw is used during the reassembly process, it can damage the unit. HP 
strongly recommends that all screws removed during disassembly be kept with the part that was removed, 
then returned to their proper locations.

CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the work area 
to prevent damage.

Cables and connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with care to 
avoid damage. Apply only the tension required to seat or unseat the cables during insertion or removal from 
the connector. Handle cables by the connector whenever possible. In all cases, avoid bending or twisting the 
cables, and ensure that the cables are routed in such a way that they cannot be caught or snagged by parts 
being removed or replaced.

CAUTION: When servicing this computer, ensure that cables are placed in their proper location during the 
reassembly process. Improper cable placement can damage the computer. 

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This applies 
to failed drives as well as replacement spares.

● If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective packaging 
and label the package “Fragile: Handle With Care.”

● Do not remove hard drives from the shipping package for storage. Keep hard drives in their protective 
packaging until they are actually mounted in the computer.

● Avoid dropping drives from any height onto any surface.

● If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive while the 
computer is on or in standby mode.

● Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, avoid 
touching the connector.

● Do not use excessive force when inserting a drive.

● Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields 
such as monitors or speakers.

Lithium coin cell battery

The battery that comes with the computer provides power to the real-time clock and has a minimum lifetime 
of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this guide for 
instructions on the replacement procedures.

WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the battery is 
handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in water or fire, or 
expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the battery.
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NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the general 
household waste. In order to forward them to recycling or proper disposal, please use the public collection 
system or return them to HP, their authorized partners, or their agents.

SATA hard drives

Serial ATA Hard Drive Characteristics  

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)

Data interface voltage differential 400-700 mV

Drive voltages 3.3 V, 5 V, 12 V

Jumpers for configuring drive N/A

Data transfer rate 6.0 Gb/s

SATA hard drive cables

SATA data cable

Always use an HP approved SATA 6.0 Gb/s cable as it is fully backwards compatible with the SATA 1.5 Gb/s 
drives.

Current HP desktop products ship with SATA 6.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and never bend it 
tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.

SMART ATA drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal Computers 
have built-in drive failure prediction that warns the user or network administrator of an impending failure or 
crash of the hard drive. The SMART drive tracks fault prediction and failure indication parameters such as 
reallocated sector count, spin retry count, and calibration retry count. If the drive determines that a failure is 
imminent, it generates a fault alert.
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Cable management
Always follow good cable management practices when working inside the computer.

● Keep cables away from major heat sources like the heat sink.

● Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these are not 
designed to take excessive pressure on them.

● Keep cables clear of sliding or moveable parts to prevent them from being cut or crimped when the parts 
are moved.

● When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the wires.

● Some flat ribbon cables come prefolded. Never change the folds on these cables.

● Do not bend any cable sharply. A sharp bend can break the internal wires.

● Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

● Never crease a SATA data cable.

● Do not rely on components like the drive cage, power supply, or computer cover to push cables down 
into the chassis. Always position the cables to lay properly by themselves.
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4 Removal and replacement procedures – 
small form factor (SFF) chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service. After 
completing all necessary removal and replacement procedures, run the Diagnostics utility to verify that all 
components operate properly.

NOTE: Not all features listed in this guide are available on all computers.

Preparation for disassembly
See Routine care, SATA drive guidelines, and disassembly preparation on page 11 for initial safety procedures.

1. Remove/disengage any security devices that prohibit opening the computer.

2. Close any open software applications.

3. Exit the operating system.

4. Remove any compact disc or media card from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the system 
is plugged into an active AC outlet. In some systems the cooling fan is on even when the computer is in 
the “Standby,” or “Suspend” modes. The power cord should always be disconnected before servicing a 
unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

NOTE: During disassembly, label each cable as you remove it, noting its position and routing. Keep all 
screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong 
screw in an application may damage the unit.

8. If the computer is on a stand, remove the computer from the stand.
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Access panel
1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Pull up the access panel handle (1), and then lift the panel off the computer (2).

To install the access panel, reverse the removal procedure.

Front bezel
1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Lift up the three tabs on the side of the bezel (1), and then rotate the bezel off the chassis (2).

To install the front bezel, reverse the removal procedure.
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Front bezel security
The front bezel can be locked in place by installing a security screw provided by HP. To install the security 
screw:

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. If you do not have a 6-32 standard screw, remove one of the four silver 6-32 standard screws located on 
top of the drive cage. Refer to Installing and Removing Drives on page 32 for an illustration of the 6-32 
standard screw locations.

4. Install the 6-32 security screw through the middle front bezel release tab to secure the front bezel in 
place.

5. Replace the computer access panel.

6. If the computer was on a stand, replace the stand.

7. Reconnect the power cord and any external devices, and then turn on the computer.

8. Lock any security devices that were disengaged when the access panel was removed.
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Slim optical drive bezel blank
On some models, there is a bezel blank covering the slim optical drive bay. Remove the bezel blank before 
installing an optical drive. To remove the bezel blank:

1. Remove the access panel (Access panel on page 20).

2. Remove the front bezel (Front bezel on page 20).

3. To remove the slim optical drive bezel blank, press inward on the three retaining tabs that hold the bezel 
blank in place (1), and then rotate the bezel blank off the front bezel (2).

NOTE: After removing the slim optical drive bezel blank and installing a slim optical drive, you can install an 
optional bezel trim piece (available from HP) that surrounds the front of the slim optical drive.
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Memory

Description

8-GB, PC3-12800

4-GB, PC3-12800

2-GB, PC3-12800

The computer comes with low power double data rate 3 synchronous dynamic random access memory 
(DDR3L-SDRAM) dual inline memory modules (DIMMs). It also supports standard DDR3-SDRAM DIMMS.

DIMMs

The memory sockets on the system board can be populated with up to four industry-standard DIMMs. These 
memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum memory 
support, you can populate the system board with up to 32-GB of memory configured in a high-performing 
dual channel mode.

DDR3/DDR3L-SDRAM DIMMs

For proper system operation, the DIMMs must be:

● industry-standard 240-pin

● unbuffered non-ECC PC3-12800 DDR3/DDR3L-1600 MHz-compliant

● 1.5 volt DDR3-SDRAM DIMMs or 1.35 volt DDR3L-SDRAM (Low Power) DIMMs

The DIMMs must also:

● support CAS latency 11 DDR3/DDR3L 1600 MHz (11-11-11 timing)

● contain the mandatory JEDEC SPD information

In addition, the computer supports:

● 512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

● single-sided and double-sided DIMMs

● DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not supported

NOTE: The system will not operate properly if you install unsupported DIMMs.

Populating DIMM sockets

There are four DIMM sockets on the system board, with two sockets per channel. The sockets are labeled 
DIMM1, DIMM2, DIMM3, and DIMM4. Sockets DIMM1 and DIMM2 operate in memory channel B. Sockets DIMM3 
and DIMM4 operate in memory channel A.

The system will automatically operate in single channel mode, dual channel mode, or flex mode, depending 
on how the DIMMs are installed.

NOTE: Single channel and unbalanced dual channel memory configurations will result in inferior graphics 
performance.
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● The system will operate in single channel mode if the DIMM sockets are populated in one channel only.

● The system will operate in a higher-performing dual channel mode if the total memory capacity of the 
DIMMs in Channel A is equal to the total memory capacity of the DIMMs in Channel B. The technology and 
device width can vary between the channels. For example, if Channel A is populated with two 1-GB 
DIMMs and Channel B is populated with one 2-GB DIMM, the system will operate in dual channel mode.

● The system will operate in flex mode if the total memory capacity of the DIMMs in Channel A is not equal 
to the total memory capacity of the DIMMs in Channel B. In flex mode, the channel populated with the 
least amount of memory describes the total amount of memory assigned to dual channel and the 
remainder is assigned to single channel. For optimal speed, the channels should be balanced so that the 
largest amount of memory is spread between the two channels. If one channel will have more memory 
than the other, the larger amount should be assigned to Channel A. For example, if you are populating 
the sockets with one 2-GB DIMM, and three 1-GB DIMMs, Channel A should be populated with the 2-GB 
DIMM and one 1-GB DIMM, and Channel B should be populated with the other two 1-GB DIMMs. With this 
configuration, 4-GB will run as dual channel and 1-GB will run as single channel.

● In any mode, the maximum operational speed is determined by the slowest DIMM in the system.

Installing DIMMs

CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power to drain 
before adding or removing memory modules. Regardless of the power-on state, voltage is always supplied to 
the memory modules as long as the computer is plugged into an active AC outlet. Adding or removing 
memory modules while voltage is present may cause irreparable damage to the memory modules or system 
board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is important 
to use memory modules with gold-plated metal contacts to prevent corrosion and/or oxidation resulting from 
having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before beginning 
these procedures, ensure that you are discharged of static electricity by briefly touching a grounded metal 
object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage the 
module.

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Rotate up the internal drive bay housing to access the memory module sockets on the system board.

24 Chapter 4   Removal and replacement procedures – small form factor (SFF) chassis



4. Open both latches of the memory module socket (1), and insert the memory module into the socket (2).

NOTE: A memory module can be installed in only one way. Match the notch on the module with the tab 
on the memory socket.

Populate the black DIMM sockets before the white DIMM sockets.

For maximum performance, populate the sockets so that the memory capacity is spread as equally as 
possible between Channel A and Channel B. Refer to Populating DIMM sockets on page 23 for more 
information.

5. Push the module down into the socket, ensuring that the module is fully inserted and properly seated. 
Make sure the latches are in the closed position (3).

6. Repeat steps 4 and 5 to install any additional modules.

7. Replace the access panel.

8. If the computer was on a stand, replace the stand.

9. Reconnect the power cord and turn on the computer.

10. Lock any security devices that were disengaged when the access panel was removed.

The computer should automatically recognize the additional memory the next time you turn on the computer.
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Expansion card

Description

nVIDIA GT730 Grayling 2 GB DDR3 PCIex8

USB 3.1 Type Cx1 PCIe x1 card

Printer port, PCI card

Serial port, PCI card

PCIe to M.2 adapter

Intel PRO/1000 NIC

WLAN 802.11 a/b/g/n + Bluetooth 4.0 module

WLAN 802.11 (7265NV) a/b/g/n 2x2 + Bluetooth 4.0 module

WLAN 802.11 (7265AN) a/b/g/n 2x2

WLAN module caddy card + Bluetooth

M.2 USB cable

Wireless antenna for use with WLAN modules

The computer has two PCI Express x1 expansion sockets, one PCI Express x16 expansion socket, and one PCI 
Express x16 expansion socket that is downshifted to a x4 socket.

NOTE: The PCI Express sockets support only low profile cards.

You can install a PCI Express x1, x4, x8, or x16 expansion card in the PCI Express x16 socket.

For dual graphics card configurations, the first (primary) card must be installed in the PCI Express x16 socket 
that is NOT downshifted to a x4.

To remove, replace, or add an expansion card:

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Locate the correct vacant expansion socket on the system board and the corresponding expansion slot 
on the back of the computer chassis.

26 Chapter 4   Removal and replacement procedures – small form factor (SFF) chassis



4. Release the slot cover retention latch that secures the slot covers by lifting the tab on the latch and 
rotating the latch to the open position.

5. Before installing an expansion card, remove the expansion slot cover or the existing expansion card.

NOTE: Before removing an installed expansion card, disconnect any cables that may be attached to 
the expansion card.

a. If you are installing an expansion card in a vacant socket, remove the appropriate expansion slot 
cover on the back of the chassis. Pull the slot cover straight up then away from the inside of the 
chassis.
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b. If you are removing a PCI Express x1 card, hold the card at each end, and carefully rock it back and 
forth until the connectors pull free from the socket. Pull the expansion card straight up from the 
socket (1) then away from the inside of the chassis to release it from the chassis frame (2). Be sure 
not to scrape the card against the other components.

c. If you are removing a PCI Express x16 card, pull the retention arm on the back of the expansion 
socket away from the card and carefully rock the card back and forth until the connectors pull free 
from the socket. Pull the expansion card straight up from the socket then away from the inside of 
the chassis to release it from the chassis frame. Be sure not to scrape the card against the other 
components.

6. Store the removed card in anti-static packaging.

7. If you are not installing a new expansion card, install an expansion slot cover to close the open slot.

CAUTION: After removing an expansion card, you must replace it with a new card or expansion slot 
cover for proper cooling of internal components during operation.
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8. To install a new expansion card, hold the card just above the expansion socket on the system board then 
move the card toward the rear of the chassis (1) so that the bracket on the card is aligned with the open 
slot on the rear of the chassis. Press the card straight down into the expansion socket on the system 
board (2).

NOTE: When installing an expansion card, press firmly on the card so that the whole connector seats 
properly in the expansion card socket.

9. Rotate the slot cover retention latch back in place to secure the expansion card.

10. Connect external cables to the installed card, if needed. Connect internal cables to the system board, if 
needed.

11. Replace the computer access panel.

12. If the computer was on a stand, replace the stand.

13. Reconnect the power cord and any external devices, and then turn on the computer.
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14. Lock any security devices that were disengaged when the access panel was removed.

15. Reconfigure the computer, if necessary.

Drives

Description

Hard drives/Solid-state drives

2-TB, 7200-rpm

1-TB, 7200-rpm, 3.5-inch

1-TB, 7200-rpm, 2.5-inch

1-TB, hybrid SSD, 3.5-inch or 2.5-inch

500-GB, 7200-rpm, 2.5-inch, SED

500 GB, 7200 rpm, 3.5-inch or 2.5-inch

500-GB, 7200-rpm, 2.5-inch, OPAL2, self-encrypting drive (SED)

500-GB, 5400-rpm, 2.5-inch, FIPS

500-GB, hybrid SSD, 2.5-inch or 2.5-inch

500-GB, 5400-rpm, 2.5-inch, 5 mm

512 GB Solid-state Drive (SSD)

512-GB Solid-state Drive (SSD), M.2, 2280SS, PCIe

256-GB Solid-state Drive (SSD), self-encrypting (SED)

256-GB Solid-state Drive (SSD)

256-GB Solid-state Drive (SSD), TLC

256-GB Solid-state Drive (SSD), M.2, 2280SS, PCIe

180 GB Solid-state Drive (SSD)

180 GB Solid-state Drive (SSD), OPAL2, MLC

128-GB Solid-state Drive (SSD), self-encrypting drive (SED)

128-GB Solid-state Drive (SSD)

128-GB Solid-state Drive (SSD), TLC

128-GB Solid-state Drive (SSD), M.2, 2280SS, PCIe

120-GB Solid-state Drive (SSD)

120-GB Solid-state Drive (SSD), OPAL2, MLC

Optical drives

DVD±RW drive

DVD-ROM drive

Blu-ray BD-Writer XL Drive
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System board connections

Refer to the following illustration and table to identify the system board connectors for your model.

No. System Board Connector System Board Label Color Component

1 PCI Express x16 Gen 2 
downshifted to a x4

X4PCIEXP white Expansion Card

2 PCI Express x1 Gen 2 X1PCIEXP2 black Expansion Card

3 PCI Express x1 Gen 2 X1PCIEXP1 black Expansion Card

4 PCI Express x16 Gen 3 X16PCIEXP black Expansion Card

5 Serial Port COMB black Optional Second Serial Port

6 DIMM4 (Channel A) DIMM4 white Memory Module

7 DIMM3 (Channel A) DIMM3 black Memory Module

8 DIMM2 (Channel B) DIMM2 white Memory Module

9 DIMM1 (Channel B) DIMM1 black Memory Module

10 SATA 3.0 SATA2 light blue Any SATA Device other than the Primary 
Hard Drive

11 SATA 3.0 SATA1 light blue Any SATA Device other than the Primary 
Hard Drive

12 SATA 3.0 SATA0 dark blue Primary Hard Drive

13 Battery BAT black Battery

Drives 31



Drive positions

1 9.5mm slim optical drive bay

2 3.5-inch primary hard drive bay

3 3.5-inch secondary hard drive bay

4 2.5-inch hard drive bay

NOTE: The drive configuration on your computer may be different than the drive 
configuration shown above.

To verify the type and size of the storage devices installed in the computer, run Computer Setup.

Installing and Removing Drives

When installing drives, follow these guidelines:

● The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA connector on 
the system board labeled SATA0.

● Connect secondary hard drives and optical drives to one of the light blue SATA connectors on the system 
board (labeled SATA1 and SATA2).
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● HP has provided extra 6-32 hard drive mounting screws installed on the top of the hard drive cage (1) for 
installing a hard drive into the 3.5-inch secondary hard drive bay. If you are replacing a hard drive, 
remove the mounting screws from the old drive and install them in the new drive.

NOTE: You can also use one of the extra mounting screws to secure the front bezel (see Front bezel 
security on page 21 for more information).

CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the computer, and 
unplug the power cord. Do not remove a drive while the computer is on or in standby mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, avoid 
touching the connector.

Handle a drive carefully; do not drop it.

Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields such as 
monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and label the 
package “Fragile: Handle With Care.”
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Removing a 9.5mm slim optical drive

CAUTION: All removable media should be taken out of a drive before removing the drive from the computer.

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Disconnect the power cable (1) and data cable (2) from the rear of the optical drive, push the green 
release latch on the right rear side of the drive toward the center of the drive (3), and then slide the drive 
forward and out of the bay through the front bezel (4).

CAUTION: When removing the cables, pull the tab or connector instead of the cable itself to avoid 
damaging the cable.
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Installing a 9.5mm slim optical drive

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Remove the front bezel if you are installing a drive in a bay covered by a bezel blank, then remove the 
bezel blank. See Front bezel on page 20 for more information.

4. Align the small pin on the release latch with the small hole on the side of the drive and press the latch 
firmly onto the drive.

5. Slide the optical drive through the front of the chassis all the way into the bay so that it locks in place 
(1), and then connect the power cable (2) and data cable (3) to the rear of the drive.

6. Connect the opposite end of the data cable to one of the light blue SATA connectors on the system 
board.

NOTE: Refer to System board connections on page 31 for an illustration of the system board drive 
connectors.
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7. Replace the front bezel if it was removed.

8. Replace the computer access panel.

9. If the computer was on a stand, replace the stand.

10. Reconnect the power cord and any external devices, and then turn on the computer.

11. Lock any security devices that were disengaged when the access panel was removed.

Removing and replacing a primary 3.5-inch hard drive

NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so that you 
can transfer the data to the new hard drive.

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Disconnect the power cable (1) and data cable (2) from the back of the hard drive.

36 Chapter 4   Removal and replacement procedures – small form factor (SFF) chassis



4. Pull the release lever next to the rear of the hard drive outward (1). While pulling the release lever out, 
slide the drive back until it stops, and then lift the drive up and out of the bay (2).

5. To install a hard drive, you must transfer the mounting screws from the old hard drive to the new hard 
drive.
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6. Align the mounting screws with the slots on the chassis drive cage, press the hard drive down into the 
bay, and then slide it forward until it stops and locks in place.

7. Connect the power cable (1) and data cable (2) to the back of the hard drive.

NOTE: The data cable for the primary hard drive must be connected to the dark blue connector on the 
system board labeled SATA0 to avoid any hard drive performance problems.

8. Replace the computer access panel.

9. If the computer was on a stand, replace the stand.

10. Reconnect the power cord and any external devices, and then turn on the computer.

11. Lock any security devices that were disengaged when the access panel was removed.
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Removing a secondary 3.5-inch hard drive

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Rotate the drive cage to its upright position.

4. Disconnect the power cable (1) and data cable (2) from the rear of the hard drive. Press the latch on the 
side of the drive cage (3), and then slide the drive out of the drive bay (4).

5. If you are installing a new drive, refer to Installing a secondary 3.5-inch hard drive on page 40. If you 
are not installing a new drive, rotate the drive cage down and replace the access panel.
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Installing a secondary 3.5-inch hard drive

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Install four silver 6-32 mounting screws on the sides of the drive (two on each side).

NOTE: HP has supplied four extra silver 6-32 mounting screws installed on the chassis next to the 
primary 3.5-inch hard drive bay. Refer to Installing and Removing Drives on page 32 for an illustration of 
the location of the extra mounting screws.

When replacing a drive, transfer the four mounting screws from the old drive to the new drive.

4. Rotate the drive cage to its upright position.
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5. Slide the drive into the drive bay (1), and then connect the power cable (2) and data cable (3) to the rear 
of the hard drive.

NOTE: If the drive is a secondary hard drive, connect the other end of data cable to one of the light 
blue SATA connectors on the system board. If the drive is the primary hard drive, connect the other end 
of the data cable to the dark blue SATA connector on the system board.

6. Rotate the drive cage back down to its normal position.

CAUTION: Be careful not to pinch any cables or wires when rotating the drive cage down.

7. Replace the computer access panel.

8. If the computer was on a stand, replace the stand.

9. Reconnect the power cord and any external devices, and then turn on the computer.

10. Lock any security devices that were disengaged when the access panel was removed.
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Removing a 2.5-inch hard drive

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Rotate the drive cage to its upright position.

4. Disconnect the power cable (1) and data cable (2) from the back of the hard drive.
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5. Pull outward on the release lever at the rear of the drive (1) then slide the drive back until it stops and 
pull it down and out of the drive bay (2).

6. If you are installing a new drive, refer to Installing a 2.5-inch hard drive on page 43. If you are not 
installing a new drive, rotate the drive cage down and replace the access panel.

Installing a 2.5-inch hard drive

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Install four black and blue M3 isolation mounting guide screws (two on each side of the drive).

NOTE: M3 metric isolation mounting guide screws can be purchased from HP.

When replacing a drive, transfer the four mounting screws from the old drive to the new drive.
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4. Rotate the drive cage to its upright position.

5. Align the mounting screws on the drive with the J-slots on the sides of the drive bay. Press the drive up 
into the drive bay then slide it forward until it locks in place.
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6. Connect the power cable (1) and data cable (2) to the back of the hard drive.

NOTE: If the 2.5-inch hard drive is the primary drive, connect the other end of the data cable to the 
dark blue SATA connector on the system board labeled SATA0 . If it is a secondary hard drive, connect the 
other end of the data cable to one of the light blue SATA connectors on the system board.

7. Rotate the drive cage back down to its normal position.

CAUTION: Be careful not to pinch any cables or wires when rotating the drive cage down.

8. Replace the computer access panel.

9. If the computer was on a stand, replace the stand.

10. Reconnect the power cord and any external devices, and then turn on the computer.

11. Lock any security devices that were disengaged when the access panel was removed.
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Drive power cable
1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Rotate the drive cage to its upright position.

4. Disconnect the cable from the system board connector labeled SATAPWR0.

5. Disconnect the cable from the hard drive and the optical drive.

6. Remove the cable from the clips on the base pan and on the drive cage, and then remove the drive 
power cable from the computer.

To reinstall the drive power cable, reverse the removal procedure.
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Small baffle
The small baffle sits between the fan sink and the rear of the computer.

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Rotate the baffle upward.

4. Pull the baffle away from the rear of the computer to disengage the clips on the baffle from the rear of 
the computer.
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To install the small baffle, reverse the removal procedure.

Fan baffle
The fan baffle sits on top of the fan sink.

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Remove the power cable from the clips on top of the baffle.

4. Lift the baffle off the fan sink and out of the computer.

To install the fan baffle, reverse the removal procedure.
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Hood lock
The hood lock is attached to the rear of the chassis.

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. On the rear of the computer, remove the security screw that secures the lock.

NOTE: The security screw requires a special security wrench to remove.

4. From the inside of the computer, lift the hood lock out of the computer..

To install the hood lock, reverse the removal procedure.

When installing the hood lock, on the inside rear of the computer, insert the clips on the back of the lock into 
the slots on the computer rear panel (1), and then rotate the lock down into place (2).
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Front I/O assembly
The front I/O assembly is attached to the front of the chassis with one screw. Push the assembly into the 
chassis to remove.

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Remove the front bezel (Front bezel on page 20).

4. Rotate the drive cage to its upright position.

5. Disconnect the cables from the system board as follows:

(1) Yellow connector labeled FRONT_USB

(2) Blue connector labeled FRONT AUD

(3) Blue connector labeled FRONT_USB3.0

6. Remove the cables from the three clips built into the basepan (4).

7. Remove the Torx T15 screw (1) that secures the assembly to the front of the chassis.
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8. Press the tab on the right side of the assembly (2), and then push the assembly into the computer.

9. Remove the front I/O assembly from the inside of the computer.

To install the front I/O assembly, reverse the removal procedure.

NOTE: Be sure to correctly route the cables beneath the drive cage when reinstalling the assembly. Proper 
cable routing prevents damage to the cables and allows the drive cage to close properly.
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Power switch
The power switch is attached to the left, front of the chassis.

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Remove the front bezel (Front bezel on page 20).

4. Rotate the drive cage to its upright position.

5. From the inside of the front of the chassis, press the tab at the top of the power switch (1) and push the 
top of the power switch away from the front of the chassis (2).

6. Remove the cable from the clips built into the bottom of the chassis, then and disconnect the power 
switch cable from the system board connector labeled PB/LED.

7. Remove the power switch assembly from the inside of the computer.
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To install the power switch, reverse the removal procedures.

Speaker
The speaker is attached to the front of the chassis under the rotating drive cage.

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Remove the front bezel (Front bezel on page 20).

4. Rotate the drive cage to its upright position.

5. From the outside, front of the chassis, remove the two Torx T15 screws that secure the speaker.

6. From the inside of the chassis, disconnect the speaker cable from the white system board labeled SPKR, 
and the remove the speaker from the chassis.

To install the speaker, reverse the removal procedures.
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Fan sink
CAUTION: The bond between the fan sink and the processor may be very tight. 

If the computer will power on, before removing the fan sink, turn on the computer until it warms the fan sink. 
Warming the heat sink lessens the bond between the fan sink and the processor, thereby making separating 
them easier.

Make sure not to pull the processor out of the socket when you lift the fan sink, especially if you cannot warm 
the fan sink prior to removal. Inadvertently removing the processor can damage the pins.

The fan sink is secured atop the processor with four captive Torx screws. The fan sink does not include a fan.

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Rotate the drive cage to its upright position.

4. Rotate the small baffle into the upright position (Small baffle on page 47).

5. Remove the fan baffle (Fan baffle on page 48).

6. Disconnect the fan cable from the system board connector labeled CPUFAN (1), and then loosen the four 
captive screws (2) that secure the fan sink to the system board tray.

CAUTION: Fan sink retaining screws should be removed in diagonally opposite pairs (as in an X) to even 
the downward forces on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

7. Lift the fan sink from atop the processor (3) and set it on its side to keep from contaminating the work 
area with thermal grease.

When reinstalling the fan sink, make sure that its bottom has been cleaned with an alcohol wipe and fresh 
thermal grease has been applied to the top of the processor.
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CAUTION: Fan sink retaining screws should be tightened in diagonally opposite pairs (as in an X) to evenly 
seat the fan sink on the processor to avoid damage that could require replacing the system board.

Failure to install the baffle may cause the computer to overheat.

Processor

Description

AMD A10-8850B, 3.9 GHz

AMD A10-8750B, 3.6 GHz

AMD A10-7800B, 3.57 GHz

AMD A8-8650B, 3.2 GHz

AMD A8-7600B, 3.1 GHz

AMD A6-8550B, 3.7 GHz

AMD A6-8350B, 3.5 GHz

AMD A4-7300B, 3.8 GHz

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Rotate the drive cage to its upright position.

4. Rotate the small baffle into the upright position (Small baffle on page 47).

5. Remove the fan baffle (Fan baffle on page 48).

6. Remove the heat sink (Fan sink on page 55).

7. Rotate the locking lever to its full open position (1).
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8. Carefully lift the processor from the socket (2).

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and handling 
them could cause irreparable damage. Once pins are damaged it may be necessary to replace the 
system board.

The heat sink must be installed within 24 hours of installing the processor to prevent damage to the 
processor’s solder connections.

To replace the processor, reverse the removal procedures.

NOTE: After installing a new processor onto the system board, always update the system ROM to ensure 
that the latest version of the BIOS is being used on the computer. The latest system BIOS can be found on the 
Web at: http://h18000.www1.hp.com/support/files.
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Power supply

Description

Power supply, 200W, 92% efficient

Power supply, 200W, 85% efficient

Power supply, 200W, standard

WARNING! To reduce potential safety issues, only the power supply provided with the computer, a 
replacement power supply provided by HP, or a power supply purchased as an accessory from HP should be 
used with the computer.

WARNING! Voltage is always present on the system board when the computer is plugged into an active AC 
outlet. To avoid possible personal injury and damage to the equipment the power cord should be 
disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Rotate the drive cage up.

4. Disconnect all power cables from the system board as follows:

● (1): PWR

● (2): PWRCMD

● (3): PWRCPU
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5. From the outside, rear of the chassis, remove the three Torx T15 that secure the power supply to the 
back of the chassis.

6. From the inside of the chassis, push the release lever at the front of the power supply (1), slide the 
power supply forward, and then remove it from the chassis (2).

To install the power supply, reverse the removal procedure.

CAUTION: When installing the power supply cables, make sure they are properly positioned so they are not 
cut by the drive cage and are not pinched by the rotating power supply.
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System board
NOTE: All system board spare part kits include replacement thermal material.

NOTE: System board appearance may vary.

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Remove the access panel (Access panel on page 20).

3. Rotate the small baffle into the upright position (Small baffle on page 47).

4. Remove the fan baffle (Fan baffle on page 48).

5. Rotate the drive cage to its upright position.

6. When replacing the system board, make sure the following components are removed from the defective 
system board and installed on the replacement system board:

● Memory modules (Memory on page 23)

● Expansion cards (Expansion card on page 26)

● Heat sink (Fan sink on page 55)

● Processor (Processor on page 56)

7. Disconnect all cables connected to the system board, noting their location for reinstallation.

8. Remove the eight Torx T15 screws that secure the system board to the chassis.

9. Slide the system board toward the front of the computer to disengage the I/O panel, and then lift the 
system board out of the computer.

When reinstalling the system board, first insert the I/O panel back into the slots in the rear of the chassis, and 
then align the board with the chassis screw holes.

NOTE: When replacing the system board, you must change the chassis serial number in the BIOS.
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System board callouts

Sys Bd Label Color Component  Sys Bd Label Color Component

PWRCPU White 4-pin processor power  SATA2 Light blue Any SATA Device other 
than primary hard drive

CPU Black Processor  SATA1 Light blue Any SATA Device other 
than primary hard drive

CPUFAN White Processor fan  SPKR White Speaker

DIMM1 Black Memory module  SATA0 Dark blue Hard drive

DIMM2 White Memory module  FRONT USB Yellow Front I/O

DIMM3 Black Memory module  BATTERY Black RTC battery

DIMM4 White Memory module  FRONT AUD Blue Front I/O

PSWD Green Clear system passwords  X4PCIEXP Black Expansion card

PB/LED Black Front I/O/power switch  X1PCIEXP2 Black Expansion card

PWRCMD White Power supply  X1PCIEXP1 Black Expansion card

SATAPWR0 Black Drives  X16PCIEXP White Expansion card

PWR White 6-pin main power  HLCK Black Hood lock

CMOS Yellow Reset CMOS  COMB Black Optional second serial port

FRONT USB3.0 Blue Front I/O/power switch  HSENSE White Hood sensor
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Using the Small Form Factor Computer in a Tower Orientation
The Small Form Factor computer can be used in a tower orientation. The HP logo plate on the front bezel is 
adjustable for either desktop or tower orientation.

1. Prepare the computer for disassembly (Preparation for disassembly on page 19).

2. Orient the computer so that its right side is facing down and place the computer in the optional stand.

NOTE: To stabilize the computer in a tower orientation, HP recommends the use of the optional tower 
stand.

3. Reconnect the power cord and any external devices, and then turn on the computer.

NOTE: Ensure at least 10.2 centimeters (4 inches) of space on all sides of the computer remains clear 
and free of obstructions.

4. Lock any security devices that were disengaged when the access panel was removed.
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5 Computer Setup (F10) Utility

Computer Setup (F10) Utilities
Use Computer Setup (F10) Utility to do the following:

● Change factory default settings.

● View the system configuration, including settings for processor, graphics, memory, audio, storage, 
communications, and input devices.

● Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash media devices.

● Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test (POST) 
messages. Post Messages Disabled suppresses most POST messages, such as memory count, product 
name, and other non-error text messages. If a POST error occurs, the error is displayed regardless of the 
mode selected. To manually switch to Post Messages Enabled during POST, press any key (except F1 
through F12).

● Establish an Ownership Tag, the text of which is displayed each time the system is turned on or 
restarted.

● Enter the Asset Tag or property identification number assigned by the company to this computer.

● Enable the power-on password prompt during system restarts (warm boots) as well as during power-on.

● Establish a setup password that controls access to the Computer Setup (F10) Utility and the settings 
described in this section.

● Secure integrated I/O functionality, including the serial, USB, or parallel ports, audio, or embedded NIC, 
so that they cannot be used until they are unsecured.

● Enable or disable removable media boot ability.

● Solve system configuration errors detected but not automatically fixed during the Power-On Self-Test 
(POST).

● Replicate the system setup by saving system configuration information on a USB device and restoring it 
on one or more computers.

● Enable or disable DriveLock security (when supported by drive).

Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system. To access the 
Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.

2. Repeatedly press F10 when the monitor light turns green to access the utility.

You can also press Esc to a menu that allows you to access different options available at startup, 
including the Computer Setup utility.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again 
repeatedly press F10 when the monitor light turns green to access the utility.
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3. A choice of four headings appears in the Computer Setup Utilities menu: Main, Security, Advanced, and 
UEFI Drivers.

NOTE: Selecting UEFI Drivers restarts the computer into the 3rd party option ROM management 
application. You can access this application directly by pressing F3 during startup.

4. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down) keys 
to select the option you want, then press Enter. To return to the Computer Setup Utilities menu, press 
Esc.

5. To apply and save changes, select Main > Save Changes and Exit.

● If you have made changes that you do not want applied, select Ignore Changes and Exit.

● To reset to factory settings or previously saved default settings (some models), select Apply 
Factory Defaults and Exit. This option will restore the original factory system defaults.

NOTE: Not all settings shown in the following sections are available for all models

CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup (F10) changes 
because the CMOS could become corrupted. It is safe to turn off the computer only after exiting the F10 Setup 
screen.
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Computer Setup–Main

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 5-1  Computer Setup—Main

Option Description

System Information Lists all information in following list if Advanced System Information is selected. Lists smaller subset if 
Basic System Information is selected.

● Product name

● Installed memory size

● Processor type

● Processor cache size (L1/L2/L3)

● Processor speed

● MicroCode Revision

● Processor Stepping

● DIMM size (for each installed module)

● System BIOS version

● Integrated Video BiOS Revision

● Born On Date

● Serial Number

● SKU number

● UUID (Universally Unique Identifier)

● Asset Tracking Number

● Feature Byte

● Build ID

● Product Family

● System Board ID

● System Board CT

● Integrated MAC Address

System Diagnostics Starts HP PC Hardware Diagnostics UEFI.

Lets you perform the following functions:

● Memory Test

● Hard Drive Check

● Language

Update System BIOS Lets you update the system BIOS. BIOS update binary (BIN) files must be located on the system hard drive 
or on a removable USB drive under the “Hewlett-Packard\BIOS\New” folder or under the “EFI\HP\BIOS
\New” folder.

Set Machine Unique Data Lets you update the following values:

● Feature Byte

● Build ID
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Table 5-1  Computer Setup—Main (continued)

● Serial Number

● SKU Number

● Product Family

● System Board CT

● Product Name

System IDs Lets you clear the following values:

● Asset Tracking Number

● Ownership Tag

Replicated Setup Backup current settings to USB device

Saves system configuration to a formatted USB flash media device.

Restore current settings from USB device

Restores system configuration from a USB flash media device.

Save Custom Defaults Saves the current system configuration settings as the default.

Apply Custom Defaults 
and Exit

Applies the currently selected default settings and clears any established passwords.

Apply Factory Defaults 
and Exit

Restores the factory system configuration settings as the default.

Ignore Changes and Exit Exits Computer Setup without applying or saving any changes.

Save Changes and Exit Saves changes to system configuration or default settings and exits Computer Setup.

Suppress POST Errors Suppresses most system messages during POST (Power On Self Test).

POST error messages are displayed on the display during the Power On Self Test if the BIOS encounters a 
problem while starting the computer. A POST error message will only display on screen if the computer is 
capable of booting this far. If the POST detects an error before this point, a beep code is generated 
instead.
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Computer Setup—Security

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 5-2  Computer Setup—Security

Option Description

Set up BIOS 
Administrator Password

Lets you set and enable a BIOS administrator password, which includes the following privileges:

● Manage other BIOS users

● Full access to BIOS policy and settings

● Control BIOS access of other users by setting security level

● Unlock the computer when other BIOS users fail the preboot authentication.

NOTE: Creating a BIOS user disables the Fast Boot option.

NOTE: If the password is set, it is required to change Computer Setup options, flash the ROM, and make 
changes to certain plug and play settings under Windows.

Change BIOS 
Administrator Password

(This selection is active 
only if a BIOS 
administrator password is 
set.)

Lets you change the BIOS administrator password.

You must know the current password to be able to change it.

Password Policy Let you set the guidelines for a valid password. Options include:

● Password minimum length

● Requires at least one symbol

● Requires at least one number

● Requires at least one upper case character

● Requires at least one lower case character

● Allow spaces

Clear Password Jumper

Select ‘Honor’ to engage or ‘Ignore’ to disengage the password jumper. Default is ‘Honor’.

Security Configuration Lets you activate HP SureStart.

Verify Boot Block on ever Boot

Select to enable HP SureStart.

BIOS Data Recovery Policy

Select ‘Automatic’ or ‘Manual’ to determine data recovery process.

TPM Embedded Security TPM Device

Lets you set the Trusted Platform Module as available or hidden.

TPM State

Select to enable the TPM.

TPM Clear

Select to reset the TPM to an unowned state. After the TPM is cleared, it is also turned off. To temporarily 
suspend TPM operations, turn the TPM off instead of clearing it.
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Table 5-2  Computer Setup—Security (continued)

CAUTION: Clearing the TPM resets it to factory defaults and turns it off. You will lose all created keys and 
data protected by those keys.

Set Up BIOS Power-On 
Password

Lets you set and enable a BIOS power-on password. The power-on password prompt appears after a 
power cycle or reboot. If the user does not enter the correct power-on password, the unit will not boot.

Change BIOS Power-On 
Password

(This selection is active 
only if a BIOS power-on 
password is set.)

Lets you change the BIOS power-on password.

You must know the current password to be able to change it.

DriveLock Allows you to assign or modify a master or user password for hard drives. When this feature is enabled, 
the user is prompted to provide one of the DriveLock passwords during POST. If neither is successfully 
entered, the hard drive will remain inaccessible until one of the passwords is successfully provided during 
a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the DriveLock feature is 
attached to the system.

CAUTION: Be aware that these settings take place immediately. A save is not necessary.

CAUTION: Be sure to document the DriveLock password. Losing a DriveLock password will render a drive 
permanently locked.

After you select a drive, the following options are available:

Set DriveLock Master Password. Sets the drive’s master password but does not enable DriveLock.

Enable DriveLock. Sets the drive’s user password and enables DriveLock.

Secure Erase Lets you select a hard drive to completely erase.

Once a hard drive has been erased with a program that utilizes Secure Erase firmware commands, no file 
recovery program, partition recovery program, or other data recovery method will be able to extract data 
from the drive.

Save/Restore MBR of the 
system hard drive

Enabling this feature will save the Master Boot Record (MBR) of the system hard drive. If the MBR gets 
changed, the user will be prompted to restore the MBR. Default is disabled.

The MBR contains information needed to successfully boot from a disk and to access the data stored on 
the disk. Master Boot Record Security may prevent unintentional or malicious changes to the MBR, such as 
those caused by some viruses or by the incorrect use of certain disk utilities. It also allows you to recover 
the "last known good" MBR, should changes to the MBR be detected when the system is restarted.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the current 
bootable disk while in MS-DOS or Windows Safe Mode.

NOTE: Most operating systems control access to the MBR of the current bootable disk; the BIOS cannot 
prevent changes that may occur while the operating system is running. 

Restores the backup Master Boot Record to the current bootable disk. Default is disabled.

Only appears if all of the following conditions are true:

● MBR security is enabled

● A backup copy of the MBR has been previously saved

● The current bootable disk is the same disk from which the backup copy was saved

CAUTION: Restoring a previously saved MBR after a disk utility or operating system has modified the 
MBR, may cause the data on the disk to become inaccessible. Only restore a previously saved MBR if you 
are confident that the current bootable disk's MBR has been corrupted or infected with a virus.

Smart Cover Cover Lock (Lock/Unlock)

Default is ‘Unlock’.
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Table 5-2  Computer Setup—Security (continued)

Cover Removal Sensor (Disabled/Notify user/Administrator password)

Lets you disable the cover sensor or configure what action is taken if the computer cover was removed. 
Default is ‘Disabled’.

NOTE: Notify user alerts the user that the sensor has detected that the cover has been removed. 
Administrator Password requires that the password be entered to boot the computer if the sensor 
detects that the cover has been removed.

System Management 
Command

Allows authorized personnel to reset security settings during a service event. Default is enabled.

Restore Security 
Settings to Default

Restoring settings to default requires the BIOS Administrator password.

Computer Setup—Advanced

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 5-3  Computer Setup—Advanced (for advanced users)

Option Heading

Select Language Lets you select the language of the menus in F10 Setup.

Select Keyboard Layout Lets you select language for the keyboard.

Boot Options Startup Menu Delay(sec)

Enabling this feature will add a user-specified delay to the POST process. This delay is sometimes needed 
for hard disks on some PCI cards that spin up very slowly, so slowly that they are not ready to boot by the 
time POST is finished. The POST delay also gives you more time to select F10 to enter Computer (F10) 
Setup. Default is ‘0’.

Select the devices that the computer can boot from, as well as other options, including:

● Fast Boot. Default is disabled.

● CD-ROM Boot. Default is enabled.

● Network (PXE) Boot. Default is enabled.

● SD Boot. Default is enabled.

● Netclone BIOS Boot. Default is disabled.

● Prompt on Memory Size Change. Default is enabled.

● Prompt on Fixed Storage Change. Default is disabled.

● Display Diagnostic URL. Default is enabled.

● UEFI Boot Order. Default is enabled.

● Specify the order in which UEFI boot sources (such as a internal hard drive, USB hard drive, USB 
optical drive, or internal optical drive) are checked for a bootable operating system image. Each 
device on the list may be individually excluded from or included for consideration as a bootable 
operating system source.

UEFI boot sources always have precedence over legacy boot sources.

● Legacy Boot Order

Specify the order in which legacy boot sources (such as a network interface card, internal hard drive, 
USB optical drive, or internal optical drive) are checked for a bootable operating system image. Each 
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Table 5-3  Computer Setup—Advanced (for advanced users) (continued)

device on the list may be individually excluded from or included for consideration as a bootable 
operating system source.

Specify the order of attached hard drives. The first hard drive in the order will have priority in the 
boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: To drag a device to a preferred place, press Enter. To remove the device from consideration as a 
bootable device, press F5.

You can use F5 to disable individual boot items, as well as disable UEFI boot and/or legacy boot.

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating system has 
started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the computer 
and press Esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping the boot menu) 
when the monitor light turns green. After POST is completed, a list of bootable devices is displayed. Use 
the arrow keys to select the preferred bootable device and press Enter. The computer then boots from the 
selected non-default device for this one time.

Secure Boot 
Configuration

Configure Legacy Support and Secure Boot

Legacy Support – Lets you turn off all legacy support on the computer, including booting to DOS, running 
legacy graphics cards, booting to legacy devices, and so on.

Secure Boot – Lets you make sure an operating system is legitimate before booting to it, making Windows 
resistant to malicious modification from preboot to full OS booting, preventing firmware attacks. UEFI and 
Windows Secure Boot only allow code signed by pre-approved digital certificates to run during the 
firmware and OS boot process.

Default is ‘Legacy Support Enable and Secure Boot Disable’.

Secure Boot Key Management

Lets you manage the custom key settings.

Clear Secure Boot Keys

Lets you delete any previously loaded custom boot keys. Clearing keys will disable secure boot. Default is 
disabled.

Reset Security Boot keys to factory defaults

Default is disabled.

System Options Onboard RAID (enable/disable)

Lets you enable onboard RAID. Default is disabled.

Max SATA Speed (6.0 Gbps/3.0Gbps)

Lets you set the maximum SATA drive speed to either 3.0 Gbps or 6.0 Gbps. The default is ‘6.0 Gbps’.

USB 3.0 (XHCI) (enable/disable)

Lets you enable the eXtensible Host Controller Interface (xHCI). If enabled, the USB 3.0 ports are routed to 
the xHCI controller before booting to OS. If disabled, the USB 3.0 ports are routed to the EHCI controller 
before booting to OS. The default is disabled.

After Power Loss (off/on/previous state). Default is Power off. Setting this option to:

● Power off—causes the computer to remain powered off when power is restored.

● Power on—causes the computer to power on automatically as soon as power is restored.

● Previous state—causes the computer to power on automatically as soon as power is restored, if it 
was on when power was lost.

SVM CPU VIrtualization (enable/disable)
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Table 5-3  Computer Setup—Advanced (for advanced users) (continued)

Controls the virtualization features of the processor. Changing this setting requires turning the computer 
off and then back on. Default is disabled.

Allow PCIe/PCI SERR# Interrupt (enable/disable)

Allows PCI devices to report PCI/PCIe System Error signals, such as address parity errors, data parity 
errors, and critical errors other than parity. Default is enabled.

Power Button Override (disable/4 sec/15 sec)

Lets you disable or enable and select the number of seconds you have to hold down the power button for 
it to override the system. Default is ‘4 sec’.

Built-In Device Options Embedded LAN Controller

Select to show the device in the operating system. Default is enabled.

Wake On LAN

Lets you either disable the Wake On LAN feature, or configure where the computer boots, including the 
network or hard drive. Default is Boot to Network.

Embedded WWAN Device

Select to enable.

Video Memory Size

Use this option to manage graphics memory allocation. The value you choose is allocated permanently to 
graphics and is unavailable to the operating system. For example, if you set this value to 512M on a 
system with 2 GB of RAM, the system always allocates 512 MB for graphics and the other 1.5 GB for use by 
the BIOS and operating system. Default is ‘Auto’ which sets memory allocation to 512 MB.

Audio Device

Select to show the device in the operating system. Default is enabled.

Internal Speakers (does not affect external speakers)

Select to show the device in the operating system. Default is enabled.

Integrated Microphone

Select to show the device in the operating system. Default is enabled.

Integrated Camera

Use this option to disable the integrated video controller when another video controller is present in the 
system. Default is enabled.

Increase Idle Fan Speed(%)

Sets idle fan speed percentage. This setting only changes the minimum fan speed. The fan is still 
automatically controlled.

Fingerprint Device

Select to show the device in the operating system. Default is enabled.

Touch Panel

Select to show the device in the operating system. Default is enabled.

Port Options Allows you to hide the following ports from the operating system:

● Serial port A

● SATA0

● SATA1

● SATA2
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Table 5-3  Computer Setup—Advanced (for advanced users) (continued)

● Front USB ports

● Rear USB ports

● Media card reader

Restrict USB Devices

Specify the following categories of USB devices to enable:

● Allow all USB devices

● Allow only keyboard and mouse

● Allow all but storage devices and hubs.

Option ROM Launch 
Policy

These policies control whether the Legacy Option ROM or the UEFI driver is loaded. Default is ‘All UEFI’.

Configure Option ROM Launch Policy

● All legacy

● All UEFI

● All UEFI except video

Power Management 
Options

Runtime Power Management (enable/disable)

Allows certain operating systems to reduce processor voltage and frequency when the current software 
load does not require the full capabilities of the processor. Default is enabled.

Extended Idle Power States (enable/disable)

Allows certain operating systems to decrease the processors power consumption when the processor is 
idle. Default is enabled.

S5 Maximum Power Savings (enable/disable)

Enabling this feature reduces the power of the system as much as possible in the S5 state. Power is 
removed from the wake up circuitry, the expansion slots, and any management features while in S5. 
Default is disabled.

SATA Power Management (enable/disable)

Enables or disables SATA bus and/or device power management. Default is enabled.

PCI Express Power Management (enable/disable)

Enabling this option permits the PCI Express links to use Active Power State Management (ASPM) to enter 
lower power states while not in use. Default is enabled.

Unique Sleep State Blink Rates (enable/disable)

This feature is designed to provide a visual indication of what sleep state the system is in. Each sleep 
state has a unique blink pattern. Default is disabled.

NOTE: A normal shutdown goes to the S4 state.

S0 (On) = Solid white LED.

S3 (Stand By)= 3 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds (white LED) — repeated 
cycles of 3 blinks and a pause.

S4 (Hibernation)= 4 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds (white LED) — 
repeated cycles of 4 blinks and a pause.

S5 (Soft Off) = LED is off.

Power On from Keyboard Ports (enable/disable)

Enables or disables waking from S3 due to any keyboard activity. Default is disabled.

USB Charging Port Function (enable/disable)
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Table 5-3  Computer Setup—Advanced (for advanced users) (continued)

Enables or disables the charging capability of the USB charging port. Default is enabled.

Configurations Allows you to use F10 Setup to check for BIOS updates and apply them using either a manual selection or 
an automatically scheduled check upon boot-up.

NOTE: If Windows BitLocker Drive Encryption (BDE) is enabled, HP requires that BDE be suspended 
temporarily before the BIOS is flashed. You must get the BDE recovery password and PIN before 
suspending BDE. After updating the BIOS, you can resume BDE.

Update Source (HP/Custom)

Selects hp.com or a locally managed custom address to serve BIOS updates. Default is ‘HP’.

Update Address.

If ‘Custom’ is selected for Update Source, enter the URL of the locally managed server.

Update BIOS via Network (Enabled/Disable)

Enables or disables the network BIOS update scheduler. Default is ‘Enable’.

Automatic Update Frequency (Daily, Weekly, Monthly)

If ‘Enable’ is selected for Update BIOS via Network, sets the frequency of checks to the BIOS update 
server. If a newer version of BIOS is available on the network server, the system will prompt to update the 
BIOS. Default is ‘Daily’.

Automatic BIOS Update Setting

If ‘Enable’ is selected for Update BIOS via Network, during the next boot, checks whether an updated 
BIOS is available and installs only specified updates. This value is independent of the Automatic Update 
Frequency setting.

Available configurations include:

● Check and install all BIOS updates automatically

● Check and install only important updates automatically

● Check for BIOS updates but let me decide whether to install them

Default is ‘Check and install all BIOS updates automatically’.

Check for updates now Select to check for the latest BIOS release revision on the network. Lets you decide whether to download 
the BIOS image and update the system.

Scheduled Power-On This feature wakes the system up from a powered off state at a specified date and time.

Recovering the Configuration Settings
This method of recovery requires that you first perform the Save to Removable Media command with the 
Computer Setup (F10) Utility before Restore is needed. (See Computer Setup–Main on page 65 in the 
Computer Setup—File table.)

NOTE: It is recommended that you save any modified computer configuration settings to a USB flash media 
device and save the device for possible future use.

To restore the configuration, insert the USB flash media device with the saved configuration and perform the 
Restore from Removable Media command with the Computer Setup (F10) Utility. (See Computer Setup–Main 
on page 65 in the Computer Setup—File table.)
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6 Troubleshooting without diagnostics

This chapter provides information on how to identify and correct minor problems, such as USB devices, hard 
drive, optical drive, graphics, audio, memory, and software problems. If you encounter problems with the 
computer, refer to the tables in this chapter for probable causes and recommended solutions.

NOTE: For information on specific error messages that may appear on the screen during Power-On Self-Test 
(POST) at startup, refer to POST error messages and diagnostic front panel LEDs and audible codes 
on page 106.

Safety and comfort
WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment may 
result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/ergo for 
more information on choosing a workspace and creating a safe and comfortable work environment. For more 
information, refer to the Safety & Regulatory Information guide.

Before you call for technical support
If you are having problems with the computer, try the appropriate solutions below to try to isolate the exact 
problem before calling for technical support.

● Run the HP diagnostic tool.

● Run the hard drive self-test in Computer Setup. Refer to Computer Setup (F10) Utility on page 63 for 
more information.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are error 
codes that will help you diagnose the problem. Refer to POST error messages and diagnostic front panel 
LEDs and audible codes on page 106 for more information.

● If the screen is blank, plug the monitor into a different video port on the computer if one is available. Or, 
replace the monitor with a monitor that you know is functioning properly.

● If you are working on a network, plug another computer with a different cable into the network 
connection. There may be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and see if the computer functions properly.

● If you recently installed new software, uninstall the software and see if the computer functions properly.

● Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When booting 
the operating system, use “Last Known Configuration.”

● Refer to the comprehensive online technical support at http://www.hp.com/support.

● Refer to Helpful hints on page 75 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with self-
solve diagnostics. If you need to contact HP support, use HP Instant Support Professional Edition's online chat 
feature. Access HP Instant Support Professional Edition at: http://www.hp.com/go/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online support 
information, software and drivers, proactive notification, and worldwide community of peers and HP experts.
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If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that your 
service call is handled properly:

● Be in front of your computer when you call.

● Write down the computer serial number, product ID number, and monitor serial number before calling.

● Spend time troubleshooting the problem with the service technician.

● Remove any hardware that was recently added to your system.

● Remove any software that was recently installed.

● Restore the system from the Recovery Disc Set that you created or restore the system to its original 
factory condition in System Software Requirement Disks (SSRD).

CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data files before 
running the restore process.

NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized service provider 
or dealer.

Helpful hints
If you encounter problems with the computer, monitor, or software, see the following list of general 
suggestions before taking further action:

● Check that the computer and monitor are plugged into a working electrical outlet.

● Check that the voltage select switch (some models) is set to the appropriate voltage for your region 
(115V or 230V).

● Check that the computer is turned on and the white power light is on.

● Check that the monitor is turned on and the green monitor light is on.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are error 
codes that will help you diagnose the problem. Refer to POST error messages and diagnostic front panel 
LEDs and audible codes on page 106 for more information.

● Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● Press and hold any key. If the system beeps, then the keyboard should be operating correctly.

● Check all cable connections for loose connections or incorrect connections.

● Wake the computer by pressing any key on the keyboard or pressing the power button. If the system 
remains in suspend mode, shut down the computer by pressing and holding the power button for at 
least four seconds then press the power button again to restart the computer. If the system will not shut 
down, unplug the power cord, wait a few seconds, then plug it in again. The computer will restart if it is 
set to power on automatically as soon as power is restored in Computer Setup. If it does not restart, 
press the power button to start the computer.

● Reconfigure the computer after installing a non-plug and play expansion board or other option. See 
Solving Hardware Installation Problems on page 94 for instructions.

● Be sure that all the needed device drivers have been installed. For example, if you are using a printer, 
you need a driver for that model printer.

● Remove all bootable media (CD/DVD or USB device) from the system before turning it on.
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● If you have installed an operating system other than the factory-installed operating system, check to be 
sure that it is supported on the system.

● If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed (embedded 
video on some models only) and a single monitor, the monitor must be plugged into the monitor 
connector on the source selected as the primary VGA adapter. During boot, the other monitor connectors 
are disabled and if the monitor is connected into these ports, the monitor will not function. You can 
select which source will be the default VGA source in Computer Setup.

CAUTION: When the computer is plugged into an AC power source, there is always voltage applied to the 
system board. You must disconnect the power cord from the power source before opening the computer to 
prevent system board or component damage.

Solving general problems
You may be able to easily resolve the general problems described in this section. If a problem persists and you 
are unable to resolve it yourself or if you feel uncomfortable about performing the operation, contact an 
authorized dealer or reseller.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system 
board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect 
the power cord from the wall outlet and allow the internal system components to cool before touching.

Cannot access the Computer Setup (F10) Utility when booting the computer.

Cause Solution

The Computer Setup (F10) Utility is set to “fast boot” causing the 
F10 access screen to display too briefly when booting the 
computer.

Before turning on the computer, press and hold F10. Turn on the 
computer and continue to hold F10 until the Computer Setup 
(F10) Utility is displayed.

- or –

Follow the Windows instructions for rebooting the computer into 
the Computer Setup (F10) Utility.

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four seconds 
until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to keyboard or mouse.

Cause Solution

Computer is in Sleep state. To resume from Sleep state, press the power button.

CAUTION: When attempting to resume from Sleep state, do not 
hold down the power button for more than four seconds. 
Otherwise, the computer will shut down and you will lose any 
unsaved data.

System has locked up. Restart computer.
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Computer date and time display is incorrect.

Cause Solution

RTC (real-time clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet prolongs the 
life of the RTC battery.

Reset the date and time under Control Panel (Computer Setup 
can also be used to update the RTC date and time). If the problem 
persists, replace the RTC battery. See the Removal and 
Replacement section for instructions on installing a new battery, 
or contact an authorized dealer or reseller for RTC battery 
replacement.

To access Control Panel in Windows 7, select Start, and then 
select Control Panel.

To access Control Panel in Windows 8.1, from the Start screen, 
type c, and then select Control Panel from the list of 
applications.

To access Control Panel in Windows 10, type control panel in 
the taskbar search box, and then select Control Panel.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key is turned on. Press the Num Lock key. The Num Lock light must be off if you 
want to use the arrow keys on the keypad. You can also disable or 
enable the Num Lock key in Computer Setup at Advanced > 
Device Options.

There is no sound or sound volume is too low.

Cause Solution

System volume may be set low or muted. 1. Check the Computer Setup settings to make sure the 
internal system speaker is not muted (this setting does not 
affect the external speakers).

2. Make sure the external speakers are properly connected and 
powered on and that the speakers' volume control is set 
correctly.

3. Use the system volume control available in the operating 
system to make sure the speakers are not muted or to 
increase the volume.

Cannot remove computer cover or access panel.

Cause Solution

Smart Cover Lock, featured on some computers, is locked. Unlock the Smart Cover Lock using Computer Setup.

In case of forgotten password, power loss, or computer 
malfunction, you must manually disable the Smart Cover lock . A 
key to unlock the Smart Cover Lock is not available from HP. Keys 
are typically available from a hardware store.
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Poor performance.

Cause Solution

Processor is too hot. 1. Make sure airflow to the computer is not blocked. Leave a 
10.2-cm (4-inch) clearance on all vented sides of the 
computer and above the monitor to permit the required 
airflow.

2. Make sure fans are connected and working properly (some 
fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on the 
hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive.

Program previously accessed did not release reserved memory 
back to the system.

Restart the computer.

Virus resident on the hard drive. Run virus protection program.

Too many applications running. 1. Close unnecessary applications to free up memory.

2. Add more memory.

3. Some applications run in the background and can be closed 
by right-clicking on their corresponding icons in the task 
tray. To prevent these applications from launching at 
startup:

In Windows 7:

a. Go to Start > All Programs > Accessories > Run

b. Type msconfig, and then press Enter.

c. On the Startup tab of the System Configuration Utility, 
clear applications that you do not want to launch 
automatically, and the click OK.

In Windows 8.1:

a. On the Start screen, right-click, and then select the All 
apps icon.

b. Under Windows System, click Run.

c. Type msconfig, and then press Enter.

d. On the Startup tab of the System Configuration Utility, 
clear applications that you do not want to launch 
automatically, and the click OK.

In Windows 10:

a. Type msconfig in the taskbar search box, and then 
select msconfig.

b. On the Startup tab of the System Configuration Utility, 
click Open Task Manager..

c. Select applications that you do not want to launch 
automatically, and the click Disable.

Some software applications, especially games, are stressful on 
the graphics subsystem.

1. Lower the display resolution for the current application or 
consult the documentation that came with the application 
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Poor performance.

Cause Solution

for suggestions on how to improve performance by 
adjusting parameters in the application.

2. Add more memory.

3. Upgrade the graphics solution.

Cause unknown. Restart the computer.

Computer powered off automatically and the Power LED flashes red four times and then white two times.

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and the 
processor cooling fan is running.

2. Open the access panel, press the power button, and see if 
the processor fan (or other system fan) spins. If the fan does 
not spin, make sure the fan cable is plugged onto the system 
board header.

3. If fan a plugged in and not spinning, replace it.

System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

System unable to power on. Press and hold the power button for less than 4 seconds. If the 
hard drive LED turns white, then:

1. If equipped with a voltage selector, check that the voltage 
selector (located on the rear of the power supply) is set to 
the appropriate voltage. Proper voltage setting depends on 
your region.

2. Remove the expansion cards one at a time until the 5V_aux 
light on the system board turns on.

3. Replace the system board.

OR

Press and hold the power button for less than 4 seconds. If the 
hard drive LED does not turn on white then:

1. Check that the unit is plugged into a working AC outlet.

2. Open the access panel and check that the power button 
cable is properly connected to the system board.

3. Check that the power supply cables are properly connected 
to the system board.

4. Check to see if the 5V_aux light on the system board is 
turned on. If it is turned on, then replace the power button 
assembly.

5. If the 5V_aux light on the system board is off, then replace 
the power supply.

6. Replace the system board.
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Solving power problems
Common causes and solutions for power problems are listed in the following table.

Power supply shuts down intermittently.

Cause Solution

If equipped with a voltage selector, voltage selector switch on 
rear of computer chassis (some models) not switched to correct 
line voltage (115V or 230V).

Select the proper AC voltage using the selector switch.

Power supply will not turn on because of internal power supply 
fault.

Replace the power supply.

Computer powered off automatically and the Power LED flashes red four times and then white two times.

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and the 
processor cooling fan is running.

2. Open the access panel, press the power button, and see if 
the processor fan (or other system fan) spins. If the fan does 
not spin, make sure the fan cable is plugged onto the system 
board header.

3. If fan a plugged in and not spinning, replace it.

Computer powered off automatically and the Power LED flashes red three times and then white four times.

Cause Solution

Power failure (power supply is overloaded). 1. If equipped with a voltage selector, check that the voltage 
selector, located on the rear of the power supply (some 
models), is set to the appropriate voltage. Proper voltage 
setting depends on your region.

2. Open the access panel and ensure the power supply cable is 
seated into the connector on the system board.

3. Check if a device is causing the problem by removing ALL 
attached devices (such as hard drives or optical drives and 
expansion cards). Power on the system. If the system enters 
POST, then power off and replace one device at a time and 
repeat this procedure until failure occurs. Replace the device 
that is causing the failure. Continue adding devices one at a 
time to ensure all devices are functioning properly.

4. Replace the power supply.

5. Replace the system board.
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Solving hard drive problems
Hard drive error occurs.

Cause Solution

Hard disk has bad sectors or has failed. 1. In Windows 7, click Start, click Computer, and right-click on 
a drive. Select Properties, and then select the Tools tab. 
Under Error-checking click Check Now.

In Windows 8.1, on the Start screen type e, and then select 
File Explorer from the list of applications. In the left 
column, expand Computer, right-click on a drive, select 
Properties, and then select the Tools tab. Under Error 
checking click Check.

In Windows 10, type file in the taskbar search box, and 
then select File Explorer from the list of applications. In the 
left column, expand This PC, right-click on a drive, select 
Properties, and then select the Tools tab. Under Error 
checking click Check.

2. Use a utility to locate and block usage of bad sectors. If 
necessary, reformat the hard disk.

Disk transaction problem.

Cause Solution

Either the directory structure is bad or there is a problem with a 
file.

In Windows 7, click Start, expand Computer, and right-click on a 
drive. Select Properties, and then select the Tools tab. Under 
Error-checking click Check Now.

In Windows 8.1, on the Start screen type e, and then click File 
Explorer from the list of applications. In the left column, expand 
Computer, right-click on a drive, select Properties, and then 
select the Tools tab. Under Error checking click Check.

In Windows 10, type file in the taskbar search box, and then 
select File Explorer from the list of applications. In the left 
column, expand This PC, right-click on a drive, select Properties, 
and then select the Tools tab. Under Error checking click Check.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly 
installed device.

See reconfiguration directions in the Solving Hardware 
Installation Problems on page 94 section. If the system still 
does not recognize the new device, check to see if the device is 
listed within Computer Setup. If it is listed, the probable cause is a 
driver problem. If it is not listed, the probable cause is a hardware 
problem.

If this is a newly installed drive, run the Computer Setup utility 
and try adding a POST delay under Advanced > Power-On 
Options.
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Drive not found (identified).

Cause Solution

The device is attached to a SATA port that has been hidden in 
Computer Setup.

Run the Computer Setup utility and ensure Device Available is 
selected for the device's SATA port in Security > Device Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in Advanced > 
Power-On Options.

Nonsystem disk/NTLDR missing message.

Cause Solution

The system is trying to start from the hard drive but the hard 
drive may have been damaged.

▲ Perform Drive Protection System (DPS) testing in system 
ROM.

System files missing or not properly installed. 1. Insert bootable media and restart the computer.

2. Boot to the windows installation media and select the 
recovery option. If only a restore kit is available, then select 
the File Backup Program option, and then restore the 
system.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup. Run the Computer Setup utility and enable the hard drive entry in 
the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard drive 
configuration.

If attempting to boot from a hard drive, ensure it is attached to 
the system board dark blue SATA connector.

Bootable hard drive is not listed first in the Boot Order. Run the Computer Setup utility and select Storage > Boot Order 
and ensure the bootable hard drive is listed immediately under 
the Hard Drive entry.

Computer will not boot from hard drive.

Cause Solution

The device is attached to a SATA port that has been hidden in 
Computer Setup.

1. Check SATA cable connections.

2. Run the Computer Setup utility and ensure Device Available 
is selected for the device's SATA port in Security > Device 
Security.

Boot order is not correct. Run the Computer Setup utility and change boot sequence in 
Storage  > Boot Order.

Hard Drive's “Emulation Type” is set to “None.” (some models) Run the Computer Setup utility and change the “Emulation Type” 
to “Hard Disk” in the device's details under Storage > Device 
Configuration.

Hard drive is damaged. Observe if the front panel Power LED is blinking RED and if any 
beeps are heard. See POST error messages and diagnostic front 
panel LEDs and audible codes on page 106 to determine possible 
causes for the blinking red and beep codes.

See the Worldwide Limited Warranty for terms and conditions.
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Computer seems to be locked up.

Cause Solution

Program in use has stopped responding to commands. 1. Use the task manager to close programs that do not 
respond.

2. Attempt the normal Windows “Shut Down” procedure. If this 
fails, press the power button for four or more seconds to 
turn off the power. To restart the computer, press the power 
button again.

Solving media card reader problems
Media card will not work in a digital camera after formatting it in Windows.

Cause Solution

By default, Windows will format any media card with a capacity 
greater than 32MB with the FAT32 format. Some digital cameras 
use the FAT (FAT16 & FAT12) format and can not operate with a 
FAT32 formatted card.

Either format the media card in the digital camera or select FAT 
file system to format the media card in a computer with Windows.

A write-protected or locked error occurs when attempting to write to the media card.

Cause Solution

Media card is locked. Locking the media card is a safety feature 
that prevents writing to and deleting from an SD/Memory 
Stick/PRO card.

If using an SD card, make sure that the lock tab located on the 
right of the SD card is not in the locked position. If using a Memory 
Stick/PRO card, make sure that the lock tab located on the bottom 
of the Memory Stick/PRO card is not in the locked position.

Can not write to the media card.

Cause Solution

The media card is a read-only memory (ROM) card. Check the manufacturer’s documentation included with your card 
to see if it writable. Refer to the previous section for a list of 
compatible cards.

Media card is locked. Locking the media card is a safety feature 
that prevents writing to and deleting from an SD/Memory 
Stick/PRO card.

If using an SD card, make sure that the lock tab located on the 
right of the SD card is not in the locked position. If using a Memory 
Stick/PRO card, make sure that the lock tab located on the bottom 
of the Memory Stick/PRO card is not in the locked position.

Unable to access data on the media card after inserting it into a slot.

Cause Solution

The media card is not inserted properly, is inserted in the wrong 
slot, or is not supported.

Ensure that the card is inserted properly with the gold contact on 
the correct side. The green LED will light if inserted properly.
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Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. In Windows 7, click Start, select Computer, right-click on the 
corresponding drive icon, and then select Eject. Pull the card out 
of the slot.

In Windows 8.1, on the Start screen, type e, and then click File 
Explorer from the list of applications. Expand Computer, right-
click on the corresponding drive icon, and then select Eject. Pull 
the card out of the slot.

In Windows 10, type file in the taskbar search box, and then 
select File Explorer from the list of applications. In the left 
column, expand This PC, right-click on the corresponding drive 
icon, and then select Eject. Pull the card out of the slot.

NOTE: Never remove the card when the green LED is flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized by the 
computer.

Cause Solution

The operating system needs time to recognize the device if the 
reader was just installed into the computer and you are turning 
the PC on for the first time.

Wait a few seconds so that the operating system can recognize 
the reader and the available ports, and then recognize the media 
inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause Solution

The inserted media card has boot capability. 1. If you do not want to boot from the media card, remove it 
during boot or do not select the option to boot from the 
inserted media card during the boot process.

2. During POST (Power On Self-Test), press F9 to modify the 
boot menu.

3. Change the boot sequence in F10 Computer Setup.

Solving display problems
If you encounter display problems, see the documentation that came with the monitor and to the common 
causes and solutions listed in the following table.

Blank screen (no video).

Cause Solution

Monitor is not turned on and the monitor light is not on. Turn on the monitor and check that the monitor light is on.

Bad monitor. Try a different monitor.

The cable connections are not correct. Check the cable connection from the monitor to the computer and 
to the electrical outlet.
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Blank screen (no video).

Cause Solution

You may have a screen blanking utility installed or energy saver 
features are enabled.

Press any key or click the mouse button and type your password 
(if set).

System ROM is corrupted; system is running in Boot Block 
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

You are using a fixed-sync monitor and it will not sync at the 
resolution chosen.

Be sure that the monitor can accept the same horizontal scan rate 
as the resolution chosen.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not 
hold down the power button for more than four seconds. 
Otherwise, the computer will shut down and you will lose any 
unsaved data.

Monitor cable is plugged into the wrong connector. Systems may have a monitor connection on both the 
motherboard or an add-in card. Try moving the monitor 
connection to a different connector on the back of the computer

Monitor settings in the computer are not compatible with the 
monitor.

1. In Control Panel, select Category from the View by list, then 
under Appearance and Personalization, select Adjust 
screen resolution.

To access Control Panel in Windows 7, click Start, and then 
select Control Panel.

To access Control Panel in Windows 8.1, from the Start 
screen, type c, and then select Control Panel from the list of 
applications.

To access Control Panel in Windows 10, type control 
panel in the taskbar search box, and then select Control 
Panel from the list of applications.

2. Expand the Resolution box, and then use the sliding control 
to reset the resolution.

Monitor is configured to use an input that is not active. Use the monitor's on-screen menu controls to select the input 
that is being driven by the system. Refer to the monitor's user 
documentation for more information on the on-screen controls 
and settings.

Blank screen and the power LED flashes Red five times, once every second, followed by a two second pause, and the computer 
beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video memory error. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty module.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Blank screen and the power LED flashes Red six times, once every second, followed by a two second pause, and the computer 
beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card (if applicable). Power on the 
system.

2. Replace the graphics card (if applicable).

3. Replace the system board.

For systems with integrated graphics, replace the system board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second pause, and the computer 
beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

System board failure (ROM detected failure prior to video). Replace the system board.

Monitor does not function properly when used with energy saver features.

Cause Solution

Monitor without energy saver capabilities is being used with 
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters.

Cause Solution

The brightness and contrast controls are not set properly. Adjust the monitor brightness and contrast controls.

Cables are not properly connected. Check that the graphics cable is securely connected to the 
graphics card (if applicable) or video connector and the monitor.

Blurry video or requested resolution cannot be set.

Cause Solution

If the graphics controller was upgraded, the correct graphics 
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution. Change requested resolution.

Graphics card is bad. Replace the graphics card.
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The picture is broken up, rolls, jitters, or flashes.

Cause Solution

The monitor connections may be incomplete or the monitor may 
be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the 
computer.

2. In a two-monitor system or if another monitor is in close 
proximity, be sure the monitors are not interfering with each 
other’s electromagnetic field by moving them apart.

3. Fluorescent lights or fans may be too close to the monitor.

Monitor needs to be degaussed. Degauss the monitor. Refer to the documentation that came with 
the monitor for instructions.

Image is not centered.

Cause Solution

Position may need adjustment. Press the monitor's Menu button to access the OSD menu. Select 
ImageControl/ Horizontal Position or Vertical Position to adjust 
the horizontal or vertical position of the image.

“No Connection, Check Signal Cable” displays on screen.

Cause Solution

Monitor video cable is disconnected. Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while 
connecting the video cable.

“Out of Range” displays on screen.

Cause Solution

Video resolution and refresh rate are set higher than what the 
monitor supports.

Restart the computer and enter Safe Mode. Change the settings to 
a supported setting then restart the computer so that the new 
settings take effect.

To enter Safe Mode in Windows 7:

1. Restart the computer.

2. Press and hold the F8 key as your computer restarts, before 
the Windows logo appears. If the Windows logo appears, 
you must restart the computer and try again.

3. On the Advanced Boot Options screen, use the arrow keys to 
highlight the safe mode option you want, and then press 
Enter.

4. Log on to your computer with a user account that has 
administrator rights.

When your computer is in safe mode, Safe Mode displays in 
the corners of your monitor. To exit safe mode, restart your 
computer and let Windows start normally.

To enter Safe Mode in Windows 8.1:
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“Out of Range” displays on screen.

Cause Solution

1. Press the Windows logo + l to open the Settings charm.

2. Select Change PC Settings, select General, and then under 
Advanced startup, click Restart now.

3. Select Troubleshoot, select Advanced options, select 
Startup Settings, and then click Restart.

4. Use the function keys or number keys to select the safe 
mode option you want.

When your computer is in safe mode, Safe Mode displays in 
the corners of your monitor. To exit safe mode, restart your 
computer and let Windows start normally.

To enter Safe Mode in Windows 10:

1. Log into the computer using an Administrator account.

2. Type msconfig in the taskbar search box, and then select 
msconfig from the list of applications.

3. Click the Boot tab, select Safe boot and then click OK.

High pitched noise coming from inside a flat panel monitor.

Cause Solution

Brightness and/or contrast settings are too high. Lower brightness and/or contrast settings.

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to center the 
picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause Solution

Flat panel monitor’s internal digital conversion circuits may be 
unable to correctly interpret the output synchronization of the 
graphics card.

1. Select the monitor’s Auto-Adjustment option in the 
monitor’s on-screen display menu.

2. Manually synchronize the Clock and Clock Phase on-screen 
display functions. To download a SoftPaq that will assist you 
with the synchronization, go to the following Web site, 
select the appropriate monitor, and download either 
SP32347 or SP32202: http://www.hp.com/support

Graphics card is not seated properly or is bad (some models). 1. Reseat the graphics card.

2. Replace the graphics card.

Certain typed symbols do not appear correct.

Cause Solution

The font you are using does not support that particular symbol. Use the Character Map to locate and select the appropriate 
symbol. You can copy the symbol from the Character Map into a 
document.
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Certain typed symbols do not appear correct.

Cause Solution

In Windows 7, click Start, select All Programs, select Accessories, 
select System Tools, and then select Character Map.

In Windows 8.1, on the Start screen, type ch, and then select 
Character Map  from the list of applications.

In Windows 10, type ch in the taskbar search box, and then select 
Character Map from the list of applications.

Solving audio problems
If the computer has audio features and you encounter audio problems, see the common causes and solutions 
listed in the following table.

Sound cuts in and out.

Cause Solution

Processor resources are being used by other open applications. Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.

Cause Solution

Software volume control is turned down or muted. Double-click the Speaker icon on the taskbar, then make sure 
that Mute is not selected and use the volume slider to adjust the 
volume.

NOTE: In Windows 8.1, the taskbar is available at the bottom of 
the Desktop screen.

Audio is hidden in Computer Setup. Enable the audio in Computer Setup: Security > Device Security > 
System Audio.

The external speakers are not turned on. Turn on the external speakers.

The audio device may be connected to the wrong jack. Ensure that the device is connected to the correct jack on the 
computer. The rear audio jack output is the green receptacle. The 
speakers should be plugged into the line-out jack and the 
headphones should be plugged into the headphone jack.

External speakers plugged into the wrong audio jack on a recently 
installed sound card.

See the sound card documentation for proper speaker connection. 
The rear audio jack output is the green receptacle.

Headphones or devices connected to the line-out connector mute 
the internal speaker.

Turn on and use headphones or external speakers, if connected, 
or disconnect headphones or external speakers.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not 
hold down the power button for more than four seconds. 
Otherwise, the computer will shut down and you will lose any 
unsaved data.

Internal speaker is disabled in Computer Setup. Enable the internal speaker in Computer Setup. Select Advanced > 
Device Options > Internal Speaker.
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Sound does not come out of the speaker or headphones.

Cause Solution

The application is set to use a different audio device than 
speakers.

Some graphics cards support audio over the DisplayPort 
connection (if applicable), so multiple audio devices may be listed 
in Device Manager. Make sure the correct device is being used.

To access Device Manager in Windows 7, click Start, select Control 
Panel, and then select Device Manager.

To access Device Manager in Windows 8.1, from the Start screen, 
type c, select Control Panel from the list of applications, and then 
select Device Manager.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

Some applications can select which audio output device is used. Make sure the application has selected the correct audio device.

The operating system controls may be set to use a different audio 
device as the default output device than what is expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.

Cause Solution

Headphones are plugged into the rear audio output connector. 
The rear audio output connector is for powered audio devices and 
is not designed for headphone use.

Plug the headphones into the headphone connector on the front 
of the computer.

Computer appears to be locked up while recording audio.

Cause Solution

The hard disk may be full. Before recording, make sure there is enough free space on the 
hard disk. You can also try recording the audio file in a 
compressed format.

Line-in jack is not functioning properly.

Cause Solution

Jack has been reconfigured in the audio driver or application 
software.

In the audio driver or application software, reconfigure the jack or 
set the jack to its default value.

There is no sound or sound volume is too low.

Cause Solution

The application is set to use a different audio device than 
speakers.

Some graphics cards support audio over the DisplayPort 
connection (if applicable), so multiple audio devices may be listed 
in Device Manager. Make sure the correct device is being used.

To access Device Manager in Windows 7, click Start, select Control 
Panel, and then select Device Manager.

90 Chapter 6   Troubleshooting without diagnostics



There is no sound or sound volume is too low.

Cause Solution

To access Device Manager in Windows 8.1, from the Start screen, 
type c, select Control Panel from the list of applications, and then 
select Device Manager.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

Some applications can select which audio output device is used. Make sure the application has selected the correct audio device.

The operating system controls may be set to use a different audio 
device as the default output device than what is expected.

Set the operating system to use the correct audio device.

Solving printer problems
If you encounter printer problems, see the documentation that came with the printer and to the common 
causes and solutions listed in the following table.

Printer will not print.

Cause Solution

Printer is not turned on and online. Turn the printer on and make sure it is online.

The correct printer drivers for the application are not installed. 1. Install the correct printer driver for the application.

2. Try printing using the MS-DOS command:

DIR C:\ > [printer port]

where [printer port] is the address of the printer being 
used. If the printer works, reload the printer driver.

To run MS-DOS commands, press the Windows key + r, type cmd 
in the Open box, and then click OK.

If you are on a network, you may not have made the connection 
to the printer.

Make the proper network connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on.

Cause Solution

The cables may not be connected properly. Reconnect all cables and check the power cord and electrical 
outlet.

Printer prints garbled information.

Cause Solution

The correct printer driver for the application is not installed. Install the correct printer driver for the application.
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Printer prints garbled information.

Cause Solution

The cables may not be connected properly. Reconnect all cables.

Printer memory may be overloaded. Reset the printer by turning it off for one minute, then turn it back 
on.

Printer will not print.

Cause Solution

The printer may be out of paper. Check the paper tray and refill it if it is empty.

Solving keyboard and mouse problems
If you encounter keyboard or mouse problems, see the documentation that came with the equipment and to 
the common causes and solutions listed in the following table.

A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement, jumpy mouse/keyboard, or no 
function of mouse/keyboard and external drive.

Cause Solution

If your computer is equipped with USB 3.0 ports, connected USB 
3.0 devices can interfere with the wireless keyboard USB receiver.

Connect the wireless keyboard USB receiver to a USB 2.0 port that 
is separated from ports with USB 3.0 devices. If you still 
experience interference, you may have to place the connectors 
farther apart using an external USB hub.

Keyboard commands and typing are not recognized by the computer.

Cause Solution

Keyboard connector is not properly connected. Shut down the computer, reconnect the keyboard to the back of 
the computer, and then restart the computer.

Program in use has stopped responding to commands. Shut down your computer using the mouse and then restart the 
computer.

Keyboard needs repairs. See the Worldwide Limited Warranty for terms and conditions.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep date, do not 
hold down the power button for more than four seconds. 
Otherwise, the computer will shut down and you will lose any 
unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key is on. Press the Num Lock key. The Num Lock light should be off if you 
want to use the arrow keys on the keypad. You can disable or 
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Cursor will not move using the arrow keys on the keypad.

Cause Solution

enable the Num Lock key in Computer Setup at Advanced > 
Device Options.

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse connector is not properly plugged into the back of the 
computer.

Shut down the computer using the keyboard.

Windows 7:

1. Press the Ctrl and Esc keys at the same time (or press the 
Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then press 
Enter.

3. After the shutdown is complete, plug the mouse connector 
into the back of the computer (or the keyboard) and restart.

Windows 8.1:

1. Press the Windows logo + l to open the Settings charm.

2. Use the arrow keys to select Power, and then press Enter.

3. Use the arrow keys to select Shut Down, and then press 
Enter.

4. After the shutdown is complete, plug the mouse connector 
into the back of the computer (or the keyboard) and restart.

Windows 10:

1. Press the Ctrl and Esc keys at the same time (or press the 
Windows logo key) to display the Start menu.

2. Use the arrow keys to scroll to and select the power icon at 
the top right on the menu, and then press Enter.

3. Use the arrow keys to select Shut Down, and then press 
Enter.

4. After the shutdown is complete, plug the mouse connector 
into the back of the computer (or the keyboard) and restart.

Program in use has stopped responding to commands. Shut down the computer using the keyboard then restart the 
computer.

Mouse may need cleaning. Remove the roller ball cover on the mouse and clean the internal 
components.

Mouse may need repair. See the Worldwide Limited Warranty for terms and conditions.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not 
hold down the power button for more than four seconds. 
Otherwise, the computer will shut down and you will lose any 
unsaved data.
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Mouse will only move vertically, horizontally, or movement is jerky.

Cause Solution

Mouse roller ball or the rotating encoder shafts that make contact 
with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and clean 
the internal components with a mouse cleaning kit available from 
most computer stores.

Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove hardware, such as an additional drive or 
expansion card. If you install a plug and play device, Windows automatically recognizes the device and 
configures the computer. If you install a non-plug and play device, you must reconfigure the computer after 
completing installation of the new hardware. In Windows, use the Add Hardware Wizard and follow the 
instructions that appear on the screen.

To open the Add Hardware Wizard, open a Command Prompt and open hdwwiz.exe.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system 
board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect 
the power cord from the wall outlet and allow the internal system components to cool before touching.

Table 6-1  Solving Hardware Installation Problems

A new device is not recognized as part of the system.

Cause Solution

Device is not seated or connected properly. Ensure that the device is properly and securely connected and 
that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables are 
unplugged.

Ensure that all cables are properly and securely connected and 
that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on. Turn off the computer, turn on the external device, then turn on 
the computer to integrate the device with the computer system.

When the system advised you of changes to the configuration, 
you did not accept them.

Reboot the computer and follow the instructions for accepting the 
changes.

A plug and play board may not automatically configure when 
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic settings 
for the board and choose a basic configuration that does not 
cause a resource conflict. You can also use Computer Setup to 
reconfigure or disable devices to resolve the resource conflict.

To access Device Manager in Windows 7, click Start, select Control 
Panel, and then select Device Manager.

To access Device Manager in Windows 8.1, from the Start screen, 
type c, select Control Panel from the list of applications, and then 
select Device Manager.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that Device available 
is selected for appropriate USB ports under Security > USB 
Security.
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Computer will not start.

Cause Solution

Wrong memory modules were used in the upgrade or memory 
modules were installed in the wrong location.

1. Review the documentation that came with the system to 
determine if you are using the correct memory modules and 
to verify the proper installation.

NOTE: DIMM1 or XMM1 must always be installed. DIMM1 
must be installed before DIMM2, and DIMM3 must be 
installed before DIMM4.

2. Observe the beeps and LED lights on the front of the 
computer. Beeps and flashing LEDs are codes for specific 
problems.

3. If you still cannot resolve the issue, contact Customer 
Support.

Power LED flashes Red three times and then white two times.

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system board, 
you must unplug the computer power cord before attempting to 
reseat, install, or remove a DIMM module.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty module.

NOTE: DIMM1 or XMM1 must always be installed. DIMM1 
must be installed before DIMM2, and DIMM3 must be 
installed before DIMM4

3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving Network Problems
Some common causes and solutions for network problems are listed in the following table. These guidelines 
do not discuss the process of debugging the network cabling.

Table 6-2  Solving Network Problems

Network driver does not detect network controller.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system using 
Device Manager.

To access Device Manager in Windows 7, click Start, select 
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8.1, from the Start 
screen, type c, select Control Panel from the list of 
applications, and then select Device Manager.
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Table 6-2  Solving Network Problems (continued)

Network driver does not detect network controller.

Cause Solution

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

Incorrect network driver. Check the network controller documentation for the correct driver 
or obtain the latest driver from the manufacturer’s Web site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution

No active network is detected. Check cabling and network equipment for proper connection.

Network controller is not set up properly. Check for the device status within Windows, such as Device 
Manager for driver load and the Network Connections applet 
within Windows for link status.

To access Device Manager in Windows 7, click Start, select Control 
Panel, and then select Device Manager.

To access Device Manager in Windows 8.1, from the Start screen, 
type c, select Control Panel from the list of applications, and then 
select Device Manager.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system using 
Device Manager.

To access Device Manager in Windows 7, click Start, select 
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8.1, from the Start 
screen, type c, select Control Panel from the list of 
applications, and then select Device Manager.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

Network driver is not properly loaded. Reinstall network drivers.

System cannot autosense the network. Disable auto-sensing capabilities and force the system into the 
correct operating mode.
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Diagnostics reports a failure.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network 
connector and that the other end of the cable is securely attached 
to the correct device.

The cable is attached to the incorrect connector. Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other end of 
the cable.

Ensure that the cable and device at the other end are operating 
correctly.

Network controller interrupt is shared with an expansion board. Under the Computer Setup Advanced menu, change the resource 
settings for the board.

The network controller is defective. Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause Solution

Network drivers are not loaded, or driver parameters do not 
match current configuration.

Make sure the network drivers are loaded and that the driver 
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer. Select the Network and Sharing Center icon in the Control Panel 
and configure the network controller.

To access Control Panel in Windows 7, click Start, and then select 
Control Panel.

To access Control Panel in Windows 8.1, from the Start screen, 
type c, and then select Control Panel.

To access Control Panel in Windows 10, type control panel in 
the taskbar search box, and then select Control Panel from the 
list of applications.

Network controller stopped working when an expansion board was added to the computer.

Cause Solution

Network controller interrupt is shared with an expansion board. Under the Computer Setup Advanced menu, change the resource 
settings for the board.

The network controller requires drivers. Verify that the drivers were not accidentally deleted when the 
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and conflicts 
with the embedded NIC.

Under the Computer Setup Advanced menu, change the resource 
settings for the board.

Network controller stops working without apparent cause.

Cause Solution

The files containing the network drivers are corrupted. Reinstall the network drivers using the Recovery Disc Set in 
Windows 7 or Windows recovery tools in Windows 8.1.
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Table 6-2  Solving Network Problems (continued)

Network controller stops working without apparent cause.

Cause Solution

If necessary, download the softpaq from the web (from a different 
computer).

The cable is not securely connected. Ensure that the cable is securely attached to the network 
connector and that the other end of the cable is securely attached 
to the correct device.

The network controller is defective. Contact an authorized service provider.

New network card will not boot.

Cause Solution

New network card may be defective or may not meet industry-
standard specifications.

Install a working, industry-standard NIC, or change the boot 
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present, and 
that the Remote System Installation Server contains the NIC 
drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Solving memory problems
If you encounter memory problems, some common causes and solutions are listed in the following table.

CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending on the 
Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you must unplug the 
computer power cord before attempting to reseat, install, or remove a memory module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory. 
Otherwise, the computer will not boot the operating system.

NOTE: The memory count will be affected by configurations with the Management Engine (ME) enabled. The 
ME uses 8MB of system memory in single channel mode or 16MB of memory in dual-channel mode to 
download, decompress, and execute the ME firmware for Out-of-Band (OOB), third-party data storage, and 
other management functions.
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System will not boot or does not function properly after installing additional memory modules.

Cause Solution

A memory module is not installed in the DIMM1 or XMM1 socket. Ensure that a memory module is installed in the DIMM1 or XMM1 
socket on the system board. This socket must be populated with a 
memory module.

Memory module is not the correct type or speed grade for the 
system or the new memory module is not seated properly.

Replace module with the correct industry-standard device for the 
computer. On some models, ECC and non-ECC memory modules 
cannot be mixed.

Out of memory error.

Cause Solution

You have run out of memory to run the application. Check the application documentation to determine the memory 
requirements.

Memory count during POST is wrong.

Cause Solution

The memory modules may not be installed correctly. Check that the memory modules have been installed correctly and 
that proper modules are used.

Integrated graphics may use system memory. No action required.

Insufficient memory error during operation.

Cause Solution

Too many Terminate and Stay Resident programs (TSRs) are 
installed.

Delete any TSRs that you do not need.

You have run out of memory for the application. Check the memory requirements for the application or add more 
memory to the computer.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps five times. (Beeps 
stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty module.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Solving CD-ROM and DVD problems
If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the following table 
or to the documentation that came with the optional device.

System will not boot from CD-ROM or DVD drive.

Cause Solution

The device is attached to a SATA port that has been hidden in the 
Computer Setup utility.

Run the Computer Setup utility and ensure Device Available is 
selected for the device's SATA port in Security > Device Security.

Removable Media Boot is disabled in the Computer Setup utility. Run the Computer Setup utility and enable booting to removable 
media in Storage  > Storage Options. Ensure CD-ROM is enabled 
in Storage > Boot Order.

Network Boot is enabled in Computer Setup. Run the Computer Setup utility and disable Network Boot in 
Security > Network Boot.

Non-bootable CD in drive. Try a bootable CD in the drive.

Boot order not correct. Run the Computer Setup utility and change boot sequence in 
Storage > Boot Order.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly 
installed device.

See reconfiguration directions in the Solving Hardware 
Installation Problems on page 94 section. If the system still does 
not recognize the new device, check to see if the device is listed 
within Computer Setup. If it is listed, the probable cause is a driver 
problem. If it is not listed, the probable cause is a hardware 
problem.

If this is a newly installed drive, run the Computer Setup utility 
and try adding a POST delay under Advanced  > Power-On 
Options.

The device is attached to a SATA port that has been hidden in 
Computer Setup.

Run the Computer Setup utility and ensure Device Available is 
selected for the device's SATA port in Security > Device Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in Advanced > 
Power-On Options.

CD-ROM or DVD devices are not detected or driver is not loaded.

Cause Solution

Drive is not connected properly or not properly configured. See the documentation that came with the optional device.

Movie will not play in the DVD drive.

Cause Solution

Movie may be regionalized for a different country. See the documentation that came with the DVD drive.
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Movie will not play in the DVD drive.

Cause Solution

Decoder software is not installed. Install decoder software.

Damaged media. Replace media.

Movie rating locked out by parental lock. Use DVD software to remove parental lock.

Media installed upside down. Reinstall media.

Cannot eject compact disc (tray-load unit).

Cause Solution

Disc not properly seated in the drive. Turn off the computer and insert a thin metal rod into the 
emergency eject hole and push firmly. Slowly pull the tray out 
from the drive until the tray is fully extended, then remove 
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause Solution

Media is corrupt. Try different media to confirm whether media is valid.

Media has been inserted upside down. Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to 
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive determine the 
type of media being played. If the disc still does not start, read the 
other solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit, available from most 
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive. 1. Use Device Manager to remove or uninstall the device.

To access Device Manager in Windows 7, click Start, select 
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8.1, from the Start 
screen, type c, select Control Panel from the list of 
applications, and then select Device Manager.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

2. Restart the computer and let Windows detect the CD or DVD 
driver.

Recording or copying CDs is difficult or impossible.

Cause Solution

Wrong or poor quality media type. 1. Try using a slower speed when recording.

2. Verify that you are using the correct media for the drive.
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Recording or copying CDs is difficult or impossible.

Cause Solution

3. Try a different brand of media. Quality varies widely 
between manufacturers.

Solving USB flash drive problems
If you encounter USB flash drive problems, common causes and solutions are listed in the following table.

USB flash drive is not seen as a drive letter in Windows.

Cause Solution

The drive letter after the last physical drive is not available. Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause Solution

The device is attached to a USB port that has been hidden in 
Computer Setup.

Run the Computer Setup utility and enable USB ports in 
Security > USB Security.

The device was not properly seated before power-up. Ensure the device is fully inserted into the USB port before 
applying power to the system

System will not boot from USB flash drive.

Cause Solution

Boot order is not correct. Run the Computer Setup utility and change boot sequence in 
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup utility. Run the Computer Setup utility and enable booting to removable 
media in Storage > Storage Options. Ensure USB is enabled in 
Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.

Cause Solution

Flash drive is bootable. Install the flash drive only after the operating system boots.

Flash drive is defective. Try a different flash drive.
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Solving front panel component problems
If you encounter problems with devices connected to the front panel, refer to the common causes and 
solutions listed in the following table.

A USB device, headphone, or microphone is not recognized by the computer.

Cause Solution

Device is not properly connected. 1. Turn off the computer.

2. Reconnect the device to the front of the computer and 
restart the computer.

The device does not have power. If the USB device requires AC power, be sure one end is connected 
to the device and one end is connected to a live outlet.

The correct device driver is not installed. 1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work. 1. If possible, replace the cable.

2. Restart the computer.

The device is not working. 1. Replace the device.

2. Restart the computer.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that the USB ports are 
set to Enabled in Security > USB Security.

Solving Internet access problems
If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the common 
causes and solutions listed in the following table.

Unable to connect to the Internet.

Cause Solution

Internet Service Provider (ISP) account is not set up properly. Verify Internet settings or contact your ISP for assistance.

Web browser is not set up properly. Verify that the Web browser is installed and set up to work with 
your ISP.

Cable/DSL modem is not plugged in. Plug in cable/DSL modem. You should see a “power” LED light on 
the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted due to 
bad weather.

Try connecting to the Internet at a later time or contact your ISP. 
(If the cable/DSL service is connected, the “cable” LED light on the 
front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected. Connect the CAT5 UTP cable between the cable modem and the 
computers’s RJ-45 connector. (If the connection is good, the “PC” 
LED light on the front of the cable/DSL modem will be on.)

IP address is not configured properly. Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of information 
that a Web server can store temporarily with the Web browser. 
This is useful for having the browser remember some specific 
information that the Web server can later retrieve.)

Windows 7:

1. Select Start > Control Panel.

2. Click Internet Options.
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Unable to connect to the Internet.

Cause Solution

3. In the Browsing history section on the General tab, click the 
Delete button.

4. Select the Cookies check box and click the Delete button.

Windows 8.1:

1. From the Start screen, type c, and then select Control Panel 
from the list of applications.

2. Click Internet Options.

3. In the Browsing history section on the General tab, click the 
Delete button.

4. Select the Cookies check box and click the Delete button.

Windows 10:

1. Type control panel in the taskbar search box, and then 
select Control Panel from the list of applications.

2. Click Internet Options.

3. In the Browsing history section, click the Delete button.

4. Select the Cookies and website data check box and click the 
Delete button.

Cannot automatically launch Internet programs.

Cause Solution

You must log on to your ISP before some programs will start. Log on to your ISP and launch the desired program.
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Solving software problems
Most software problems occur as a result of the following:

● The application was not installed or configured correctly.

● There is insufficient memory available to run the application.

● There is a conflict between applications.

● Be sure that all the needed device drivers have been installed.

● If you have installed an operating system other than the factory-installed operating system, check to be 
sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Computer will not continue and the HP logo does not display.

Cause Solution

ROM issue - POST error has occurred. Observe the beeps and LED lights on the front of the computer. 
See POST error messages and diagnostic front panel LEDs and 
audible codes on page 106 to determine possible causes.

See the Worldwide Limited Warranty for terms and conditions.

“Illegal Operation has Occurred” error message is displayed.

Cause Solution

Software being used is not Microsoft-certified for your version of 
Windows.

Verify that the software is certified by Microsoft for your version 
of Windows (see program packaging for this information).

Configuration files are corrupt. If possible, save all data, close all programs, and restart the 
computer.
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7 POST error messages and diagnostic front 
panel LEDs and audible codes

This appendix lists the error codes, error messages, and the various indicator light and audible sequences 
that you may encounter during Power-On Self-Test (POST) or computer restart, the probable source of the 
problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count and non-
error text messages. If a POST error occurs, the screen will display the error message. To manually switch to 
the POST Messages Enabled mode during POST, press any key (except F10, F11, or F12). The default mode is 
POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are 
determined by the POST mode selection.

Quick Boot is a fast startup process that does not run all of the system level tests, such as the memory test. 
Full Boot runs all of the ROM-based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish the 
schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

NOTE: For more information on Computer Setup, see Computer Setup (F10) Utility on page 63.

POST numeric codes and text messages
This section covers those POST errors that have numeric codes associated with them. The section also 
includes some text messages that may be encountered during POST.

NOTE: The computer will beep once after a POST text message is displayed on the screen.

Control panel message Description Recommended action

002-Option ROM Checksum Error System ROM or expansion board option ROM 
checksum.

1. Verify the correct ROM.

2. Flash the ROM if needed.

3. If an expansion board was recently added, 
remove it to see if the problem remains.

4. Clear CMOS. (See Password security and 
resetting CMOS on page 113.)

5. If the message disappears, there may be a 
problem with the expansion card.

6. Replace the system board.

003-System Board Failure DMA or timers. 1. Clear CMOS. (See Password security and 
resetting CMOS on page 113.)

2. Remove expansion boards.

3. Replace the system board.

005-Real-Time Clock Power Loss Invalid time or date in configuration memory. Reset the date and time under Control Panel 
(Computer Setup can also be used). If the 
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Control panel message Description Recommended action

RTC (real-time clock) battery may need to 
be replaced.

problem persists, replace the RTC battery. See 
the Removal and Replacement section for 
instructions on installing a new battery.

008–Microcode Patch Error Processor is not supported by the BIOS. 1. Upgrade BIOS to proper version.

2. Change the processor.

009–PMM Allocation Error during MEBx 
Download

Memory error during POST execution of the 
Management Engine (ME) BIOS Extensions 
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the 
memory modules, and reboot the 
computer.

3. If the memory configuration was recently 
changed, unplug the computer, restore 
the original memory configuration, and 
reboot the computer.

4. If the error persists, replace the system 
board.

100-Front Audio Not Connected Front audio cable has been detached or 
unseated from system board.

Reconnect or replace front audio cable.

00A-Product Information Not Valid The product information programmed into the 
system board is missing or invalid.

Use Computer Setup to update this information.

00B-MEBx Module did not checksum correctly Memory error during POST execution of the 
Management Engine (ME) BIOS Extensions 
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the 
memory modules, and reboot the 
computer.

3. If the memory configuration was recently 
changed, unplug the power cord, restore 
the original memory configuration, and 
reboot the computer.

4. If the error persists, replace the system 
board.

00C-PMM Deallocation Error during MEBx 
Cleanup

Memory error during POST execution of the 
Management Engine (ME) BIOS Extensions 
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the 
memory modules, and reboot the 
computer.

3. If the memory configuration was recently 
changed, unplug the power cord, restore 
the original memory configuration, and 
reboot the computer.

4. If the error persists, replace the system 
board.

00D-Setup Error during MEBx Execution MEBx selection or exit resulted in a setup 
failure.

1. Reboot the computer.

2. Unplug the power cord, re-seat the 
memory modules, and reboot the 
computer.

3. If the memory configuration was recently 
changed, unplug the power cord, restore 
the original memory configuration, and 
reboot the computer.
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Control panel message Description Recommended action

4. If the error persists, replace the system 
board.

00E-Inventory Error during MEBx Execution BIOS information passed to the MEBx resulted 
in a failure.

1. Reboot the computer.

2. If the error persists, update to the latest 
BIOS version.

3. If the error still persists, replace the 
system board.

00F-Interface Error during MEBx Execution MEBx operation experienced a hardware error 
during communication with the ME.

1. Reboot the computer.

2. If the error persists, update to the latest 
BIOS version.

3. If the error still persists, replace the 
system board.

2E1-MemorySize Error Memory amount has changed since the last 
boot (memory added or removed).

The system memory size is different from the 
last startup. The most common reason is the 
removal of memory from the system board. 
Press the F1 key to save the memory changes. 
If this message persists, verify that the 
memory modules are installed correctly.

2E2-Memory Error Memory module configuration failed during 
boot up.

1. Ensure memory modules are correctly 
installed.

2. Verify proper memory module type.

3. Remove and replace the identified faulty 
memory module(s).

4. If the error persists after replacing 
memory modules, replace the system 
board.

2E3-Incompatible Memory Module in Memory 
Socket(s) X, X, ...

A memory module in memory socket identified 
in the error message is missing critical SPD 
information, or is incompatible with the chipset.

1. Verify proper memory module type.

2. Try another memory socket.

3. Replace with a supported module.

2E4-DIMM Configuration Warning The current memory configuration is not 
optimized.

Rearrange the DIMMs so that each channel has 
the same amount of memory.

2E5-ECC Memory Module Detected on 
Unsupported Platform

Recently added memory module(s) support ECC 
memory error correction.

1. If additional memory was recently added, 
remove it to see if the problem remains.

2. Check product documentation for 
memory support information.

2E6–Memory Not Configured Correctly for 
Proper MEBx Execution

DIMM1 is not installed. Make sure there is a memory module in the 
DIMM1 socket and that it is properly seated.

300–Configuration Change Warning The storage device configuration will be 
updated as shown.

Not applicable

301-Hard Disk 1: SMART Hard Drive Detects 
Imminent Failure

Hard drive is about to fail. (Some hard drives 
have a hard drive firmware patch that will fix an 
erroneous error message.)

1. Determine if hard drive is giving correct 
error message. Run the Drive Protection 
System test under using F2 Diagnostics 
when booting the computer.

2. Apply hard drive firmware patch 
if applicable. (Available at 
http://www.hp.com/support.)
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Control panel message Description Recommended action

3. Back up contents and replace hard drive.

302-Hard Disk 2: SMART Hard Drive Detects 
Imminent Failure

Hard drive is about to fail. (Some hard drives 
have a hard drive firmware patch that will fix an 
erroneous error message.)

1. Determine if hard drive is giving correct 
error message. Run the Drive Protection 
System test under using F2 Diagnostics 
when booting the computer.

2. Apply hard drive firmware patch 
if applicable. (Available at 
http://www.hp.com/support.)

3. Back up contents and replace hard drive.

309 – 30C: Hard Disk 3–6: SMART Hard Drive 
Detects Imminent Failure

Hard drive is about to fail. (Some hard drives 
have a hard drive firmware patch that will fix an 
erroneous error message.)

1. Determine if hard drive is giving correct 
error message. Run the Drive Protection 
System test under using F2 Diagnostics 
when booting the computer.

2. Apply hard drive firmware patch 
if applicable. (Available at 
http://www.hp.com/support.)

3. Back up contents and replace hard drive.

3F0–Boot Device Not Found Boot device not found. Insert boot device or load operating system.

3F1–Hard Disk 1 Error Hard disk 1 error. 1. Check and/or replace cables.

2. Clear CMOS. (See Password security and 
resetting CMOS on page 113.)

3. Replace the hard disk drive.

3F2–Hard Disk 2 Error Hard disk 2 error. 1. Check and/or replace cables.

2. Clear CMOS. (See Password security and 
resetting CMOS on page 113.)

3. Replace the hard disk drive.

400-Serial Port A Address Conflict Detected Both external and internal serial ports are 
assigned to the same resources.

1. Remove any serial port expansion cards.

2. Clear CMOS. (See Password security and 
resetting CMOS on page 113.)

3. Reconfigure card resources and/or run 
Computer Setup or Windows utilities.

401-Serial Port B Address Conflict Detected Both external and internal serial ports are 
assigned to the same resources.

1. Remove any serial port expansion cards.

2. Clear CMOS. (See Password security and 
resetting CMOS on page 113.)

3. Reconfigure card resources and/or run 
Computer Setup or Windows utilities.

402-Serial Port C Address Conflict Detected Both external and internal serial ports are 
assigned to the same resources.

1. Remove any serial port expansion cards.

2. Clear CMOS. (See Password security and 
resetting CMOS on page 113.)

3. Reconfigure card resources and/or run 
Computer Setup or Windows utilities.

403-Serial Port D Address Conflict Detected Both external and internal serial ports are 
assigned to the same resources.

1. Remove any serial port expansion cards.

2. Clear CMOS. (See Password security and 
resetting CMOS on page 113.)
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Control panel message Description Recommended action

3. Reconfigure card resources and/or run 
Computer Setup or Windows utilities.

419-Out of Memory Space for Option ROMs Recently added PCI expansion card contains an 
option ROM too large to download during POST.

▲ If a PCI expansion card was recently 
added, remove it to see if the problem 
remains.

41A-Front USB1/USB2 Not Connected Front USB cable has been detached or unseated 
from system board.

Reconnect or replace front USB cable.

41B-Device in PCI Express Slot Failed To 
Initialize

There is an incompatibility or problem with a 
PCIe device and the system or PCIe link could 
not be configured to a valid bus width or speed.

Try rebooting the system. If the error reoccurs, 
the device may not work with this system

43A-USB Type-C I2C Not Connected Cable is required between I2C on card and USB-
C on the system board.

Install cable between I2C on card and USB-C on 
the system board.

43B-More Than One USB type-C Cards Are 
Installed

More than one USB type-C card is installed. Remove USB type-C card so only one is 
installed.

500–BIOS Recovery A system BIOS recovery has occurred. Not applicable.

60x-HP Battery Alert The system has detected the storage capacity 
of the battery stated below to be very low.

For optimal performance, replace the battery.

70x-Wireless Mode Not Supported The system has detected a wireless module 
installed in the system that is not supported 
and has been disabled.

Replace with a supported module.

800-Keyboard Error Keyboard failure. 1. Reconnect keyboard with computer 
turned off.

2. Check connector for bent or missing pins.

3. Ensure that none of the keys are 
depressed.

4. Replace keyboard.

801-Keyboard or System Unit Error Keyboard failure. 1. Reconnect the keyboard with computer 
turned off.

2. Ensure that none of the keys are 
depressed.

3. Replace the keyboard.

4. Replace the system board.

900-CPU Fan Not Detected CPU fan is not connected or may have 
malfunctioned.

1. Reseat CPU fan.

2. Reseat fan cable.

3. Replace CPU fan.

901-Chassis, Rear Chassis, or Front Chassis Fan 
not Detected

Chassis, rear chassis, or front chassis fan is not 
connected or may have malfunctioned.

1. Reseat chassis, rear chassis, or front 
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front 
chassis fan.

904-SATA Cabling Error One or more SATA devices are improperly 
attached. For optimal performance, the SATA 0 
and SATA 1 ports should be used for hard drives 
before other ports.

Ensure SATA connectors are used in ascending 
order. For one device, use SATA 0. For two 
devices, use SATA 0 and SATA 1. For three 
devices, use SATA 0, SATA 1, and SATA 2.

110 Chapter 7   POST error messages and diagnostic front panel LEDs and audible codes



Control panel message Description Recommended action

910–Filter Warning Airflow filter is dirty. Replace the airflow filter.

90B-Fan Failure The system has detected that a cooling fan is 
not operating correctly.

1. Reseat fan.

2. Reseat fan cable.

3. Replace fan.

90D-System Temperature Thermal shutdown occurred. The system BIOS 
has detected your machine was previously shut 
down to avoid overheating. Overheating may 
occur if the cooling vents are blocked or the 
operating temperature exceeds the system 
specifications. The machine should return to 
normal operation once the situation is resolved.

Make sure system has proper airflow.

90E-Power Supply Fan Not detected Power supply fan is not connected or may have 
malfunctioned.

1. Reseat power supply fan.

2. Reseat fan cable.

3. Replace power supply fan.

Interpreting system validation diagnostic front panel LEDs and 
audible codes

During the system validation phase that occurs at system startup, the BIOS validates the functionality of the 
following subsystems and conditions:

● AC adapter

● System board power

● Processor failure

● BIOS corruption

● Memory failure

● Graphics failure

● System board failure

● BIOS authentication failure

If an error is detected, specific patterns of long and short blinks, accompanied by long and short beeps (where 
applicable) are used to identify the error. These patterns will make up a two part code:

● Major – the category of the error

● Minor – the specific error within the category

NOTE: Single beep/blink codes are not used.

Number of long beeps/blinks Error category

1 Not used

2 BIOS

3 Hardware
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4 Thermal

5 System board

Patterns of blink/beep codes are determined by using the following parameters:

● 1 second pause occurs after the last major blink.

● 2 second pause occurs after the last minor blink.

● Beep error code sequences occur for the first 5 iterations of the pattern and then stop.

● Blink error code sequences continue until the computer is unplugged or the power button is pressed.

NOTE: Not all diagnostic lights and audible codes are available on all models.

The red LED blinks to represent the major error category (long blinks). The white LED blinks to represent the 
minor error category (short blinks). For example, ‘3.5’ indicates 3 long red blinks and 5 short white blinks to 
communicate the processor is not detected.

Category Major/minor code Description

BIOS 2.2 The main area (DXE) of BIOS has become corrupted and there is no recovery 
binary image available.

 2.3 The embedded controller policy requires the user to enter a key sequence.

 2.4 The embedded controller is checking or recovering the boot block.

Hardware 3.2 The embedded controller has timed out waiting for BIOS to return from 
memory initialization.

 3.3 The embedded controller has timed out waiting for BIOS to return from 
graphics initialization.

 3.4 The system board displays a power failure (crowbar).*

 3.5 The processor is not detected.*

 3.6 The processor does not support an enabled feature.

Thermal 4.2 A processor over temperature condition has been detected.*

 4.3 An ambient temperature over temperature condition has been detected.

 4.4 An MXM over temperature condition has been detected.

System board 5.2 The embedded controller cannot find valid firmware.

 5.3 The embedded controller has timed out waiting for the BIOS.

 5.4 The embedded controller has timed out waiting for BIOS to return from 
system board initialization.

 5.5 The embedded controller rebooted the system after a possible lockup 
condition had been detected through the use of a System Health Timer, 
Automated System Recovery Timer, or other mechanism.

* Indicates hardware triggered event; all other events are controlled by the BIOS.
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8 Password security and resetting CMOS

This computer supports security password features, which can be established through the Computer Setup 
Utilities menu.

This computer supports two security password features that are established through the Computer Setup 
Utilities menu: setup password and power-on password. When you establish only a setup password, any user 
can access all the information on the computer except Computer Setup. When you establish only a power-on 
password, the power-on password is required to access Computer Setup and any other information on the 
computer. When you establish both passwords, only the setup password will give you access to Computer 
Setup.

When both passwords are set, the setup password can also be used in place of the power-on password as an 
override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to the 
information on the computer by resetting the password jumper.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to back up the 
computer CMOS settings before resetting them in case they are needed later. Back up is easily done through 
Computer Setup. See Computer Setup (F10) Utility on page 63 for information on backing up the CMOS 
settings.

Resetting the password jumper
CAUTION: If you enable the stringent security feature in Computer Setup and you forget the setup password 
or the power-on password, the computer is inaccessible and can no longer be used.

Enabling the stringent password disables the ability to reset the password by moving the jumper on the 
system board.

If you lose or forget the password, the system board must be replaced. This scenario is not covered under 
warranty.

To prevent the computer from becoming permanently unusable, record your configured setup password or 
power-on password in a safe place away from your computer. Without these passwords, the computer cannot 
be unlocked.

To disable the power-on or setup password features, or to clear the power-on or setup passwords, complete 
the following steps:
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1. Shut down the operating system properly, then turn off the computer and any external devices, and 
disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any residual 
power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to 
disconnect the power cord from the wall outlet, and allow the internal system components to cool 
before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to the 
system board even when the unit is turned off. Failure to disconnect the power cord can result in 
damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment. Before 
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a 
grounded metal object. See the Safety & Regulatory Information guide for more information.

3. Remove the access panel.

4. Locate the header and jumper.

NOTE: The password jumper is green so that it can be easily identified. For assistance locating the 
password jumper and other system board components, see the system board components image at 
System board on page 60.

5. Remove the jumper from pins 1 and 2.

6. Place the jumper on either pin 1 or 2, but not both, so that it does not get lost.

7. Replace the access panel and reconnect the external equipment.

8. Plug in the computer and turn on power. Allow the operating system to start. This clears the current 
passwords and disables the password features.

9. Shut down the computer, unplug the power, and disconnect the external equipment.

10. Remove the access panel.

11. Place the jumper on pins 1 and 2.

12. Replace the access panel.

13. Reconnect the external equipment and plug in the computer.

Changing a Setup or Power-On password
To change the power-on or setup password, complete the following steps:

1. Turn on or restart the computer.

To change the Setup password, go to step 2.

To change the Power-on password, go to step 3.

2. To change the Setup password, as soon as the computer turns on:

- Press the Esc key while “Press the ESC key for Startup Menu” message is displayed.

- Press the F10 key to enter Computer Setup.
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3. When the key icon appears, type your current password, a slash (/) or alternate delimiter character, your 
new password, another slash (/) or alternate delimiter character, and your new password again as 
shown:

current password/new password/new password

NOTE: Type the new password carefully since the characters do not appear on the screen.

4. Press Enter.

The new password will take effect the next time the computer is restarted.

Deleting a Setup or Power-On password
To delete the power-on or setup password, complete the following steps:

1. Turn on or restart the computer.

To delete the Setup password, go to step 2.

To delete the Power-on password, go to step 3.

2. To delete the Setup password, as soon as the computer turns on:

- Press the Esc key while “Press the ESC key for Startup Menu” message is displayed.

- Press the F10 key to enter Computer Setup.

3. When the key icon appears, type your current password, a slash (/) or alternate delimiter character, your 
new password, another slash (/) or alternate delimiter character, and your new password again as 
shown:

current password/

4. Press Enter.

Clearing and resetting the CMOS
The computer’s configuration memory (CMOS) stores information about the computer’s configuration.

The CMOS button resets CMOS but does not clear the power-on and setup passwords.

1. Turn off the computer and any external devices, and disconnect the power cord from the power outlet.

2. Disconnect the keyboard, monitor, and any other external equipment connected to the computer.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to 
disconnect the power cord from the wall outlet, and allow the internal system components to cool 
before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to the 
system board even when the unit is turned off. Failure to disconnect the power cord can result in 
damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment. Before 
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a 
grounded metal object. See the Safety & Regulatory Information guide for more information.

3. Remove the access panel.
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CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to back 
up the computer CMOS settings before resetting them in case they are needed later. Back up is easily 
done through Computer Setup. See Computer Setup (F10) Utility on page 63 for information on backing 
up the CMOS settings.

4. Locate, press, and hold the CMOS button in for five seconds.

NOTE: Make sure you have disconnected the AC power cord from the wall outlet. The CMOS button will 
not clear CMOS if the power cord is connected.

NOTE: For assistance locating the CMOS button and other system board components, see the system 
board components image at System board on page 60.

5. Replace the access panel.

6. Reconnect the external devices.

7. Plug in the computer and turn on power.

NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you that 
configuration changes have occurred. Use Computer Setup to reset any special system setups along with 
the date and time.

For instructions on Computer Setup, see Computer Setup (F10) Utility on page 63.
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9 HP PC Hardware Diagnostics

To help troubleshoot and diagnose failures, use the UEFI-based hardware diagnostic solution that HP includes 
on all products. This tool can even be used if the computer will not boot to the operating system.

Why run HP PC Hardware Diagnostics
The HP PC Hardware Diagnostic tools simplify the process of diagnosing hardware issues and expedite the 
support process when issues are found. The tools save time by pinpointing the component that needs to be 
replaced.

● Isolate true hardware failures: The diagnostics run outside of the operating system so they effectively 
isolate hardware failures from issues that may be caused by the operating system or other software 
components.

● Failure ID: When a failure is detected that requires hardware replacement, a 24-digit Failure ID is 
generated. This ID can then be provided to the call agent, who will either schedule support or provide 
replacement parts.

How to access and run HP PC Hardware Diagnostics
You can run the diagnostics from one of three places, depending on your preference and the health of the 
computer.

1. Turn on the computer and press Esc repeatedly until the BIOS Boot Menu appears.

2. Press F2 or select Diagnostics (F2).

Pressing F2 signals the system to search for the diagnostics in the following locations:

a. A connected USB drive (to download the diagnostics tools to a USB drive, see the instructions in 
Downloading HP PC Hardware Diagnostics (UEFI) to a USB device on page 117)

b. The hard disk drive

c. A core set of diagnostics in the BIOS (for memory and hard disk drive) that are accessible only if the 
USB or hard disk drive versions are not detected

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device
NOTE: Instructions for downloading HP PC Hardware Diagnostics (UEFI) are provided in English only.

There are two options to download HP PC Hardward Diagnostics to USB device.

Option 1: HP PC Diagnostics homepage–Provides access to the latest UEFI version

1. Go to http://www.hp.com/go/techcenter/pcdiags.

2. Click the UEFI Dowload link, and then select Run.

Option 2: Support and Drivers pages–Provides downloads for a specific product for earlier and later 
versions.
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1. Go to http://www.hp.com.

2. Point to Support, located at the top of the page, and then click Download Drivers.

3. In the text box, enter the product name, and then click Go.

– or –

Click Find Now to let HP automatically detect your product.

4. Select your computer model, and then select your operating system.

5. In the Diagnostic section, click HP UEFI Support Environment.

6. Click Download, and then select Run.
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10 System backup and recovery

Backing up, restoring, and recovering in Windows 10
This section provides information about the following processes. The information in the section is standard 
procedure for most products.

● Creating recovery media and backups

● Restoring and recovering your system

For additional information, refer to Help and Support.

▲ Type help in the taskbar search box, and then select Help and Support.

Creating recovery media and backups

The following methods of creating recovery media and backups are available on select products only. Choose 
the available method according to your computer model.

● Use HP Recovery Manager to create HP Recovery media after you successfully set up the computer. This 
step creates a backup of the HP Recovery partition on the computer. The backup can be used to reinstall 
the original operating system in cases where the hard drive is corrupted or has been replaced. For 
information on creating recovery media, see Creating HP Recovery media (select products only) 
on page 119. For information on the recovery options that are available using the recovery media, see 
What you need to know before you get started on page 121.

● Use Windows tools to create system restore points and create backups of personal information.

For more information, see Using Windows tools on page 121.

NOTE: If storage is 32 GB or less, Microsoft System Restore is disabled by default.

Creating HP Recovery media (select products only)

If possible, check for the presence of the Recovery partition and the Windows partition. From the Start menu, 
select File Explorer.

● If your computer does not list the Windows partition and the Recovery partition, you can obtain recovery 
media for your system from support. See the Worldwide Telephone Numbers booklet included with the 
computer. You can also find contact information on the HP website. Go to http://www.hp.com/support, 
select your country or region, and follow the on-screen instructions.

You can use Windows tools to create system restore points and create backups of personal information, 
see Using Windows tools on page 121.

● If your computer does list the Recovery partition and the Windows partition, you can use HP Recovery 
Manager to create recovery media after you successfully set up the computer. HP Recovery media can be 
used to perform system recovery if the hard drive becomes corrupted. System recovery reinstalls the 
original operating system and software programs that were installed at the factory and then configures 
the settings for the programs. HP Recovery media can also be used to customize the system or restore 
the factory image if you replace the hard drive.

Backing up, restoring, and recovering in Windows 10 119

http://www.hp.com/support


◦ Only one set of recovery media can be created. Handle these recovery tools carefully, and keep 
them in a safe place.

◦ HP Recovery Manager examines the computer and determines the required storage capacity for 
the media that will be required.

◦ To create recovery discs, your computer must have an optical drive with DVD writer capability, and 
you must use only high-quality blank DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. Do not use 
rewritable discs such as CD±RW, DVD±RW, double-layer DVD±RW, or BD-RE (rewritable Blu-ray) 
discs; they are not compatible with HP Recovery Manager software. Or, instead, you can use a high-
quality blank USB flash drive.

◦ If your computer does not include an integrated optical drive with DVD writer capability, but you 
would like to create DVD recovery media, you can use an external optical drive (purchased 
separately) to create recovery discs. If you use an external optical drive, it must be connected 
directly to a USB port on the computer; the drive cannot be connected to a USB port on an external 
device, such as a USB hub. If you cannot create DVD media yourself, you can obtain recovery discs 
for your computer from HP. See the Worldwide Telephone Numbers booklet included with the 
computer. You can also find contact information on the HP website. Go to http://www.hp.com/
support, select your country or region, and follow the on-screen instructions.

◦ Be sure that the computer is connected to AC power before you begin creating the recovery media.

◦ The creation process can take an hour or more. Do not interrupt the creation process.

◦ If necessary, you can exit the program before you have finished creating all of the recovery DVDs. 
HP Recovery Manager will finish burning the current DVD. The next time you start HP Recovery 
Manager, you will be prompted to continue.

To create HP Recovery media:

1. Type recovery in the taskbar search box, and then select HP Recovery Manager.

2. Select Create recovery media, and then follow the on-screen instructions.

If you ever need to recover the system, see Recovering using HP Recovery Manager on page 121.

120 Chapter 10   System backup and recovery

http://www.hp.com/support
http://www.hp.com/support


Using Windows tools

You can create recovery media, system restore points, and backups of personal information using Windows 
tools.

NOTE: If storage is 32 GB or less, Microsoft System Restore is disabled by default.

For more information and steps, see Help and Support.

▲ Type help in the taskbar search box, and then select Help and Support.

Restore and recovery

There are several options for recovering your system. Choose the method that best matches your situation 
and level of expertise:

IMPORTANT: Not all methods are available on all products.

● Windows offers several options for restoring from backup, refreshing the computer, and resetting the 
computer to its original state. For more information see Help and Support.

▲ Type help in the taskbar search box, and then select Help and Support.

● If you need to correct a problem with a preinstalled application or driver, use the Reinstall drivers and/ 
or applications option (select products only) of HP Recovery Manager to reinstall the individual 
application or driver.

▲ Type recovery in the taskbar search box, select HP Recovery Manager, select Reinstall drivers 
and/or applications, and then follow the on-screen instructions.

● If you want to recover the Windows partition to original factory content, you can choose the System 
Recovery option from the HP Recovery partition (select products only) or use the HP Recovery media. 
For more information, see Recovering using HP Recovery Manager on page 121. If you have not already 
created recovery media, see Creating HP Recovery media (select products only) on page 119.

● On select products, if you want to recover the computer's original factory partition and content, or if you 
have replaced the hard drive, you can use the Factory Reset option of HP Recovery media. For more 
information, see Recovering using HP Recovery Manager on page 121.

● On select products, if you want to remove the recovery partition to reclaim hard drive space, HP 
Recovery Manager offers the Remove Recovery Partition option.

For more information, see Removing the HP Recovery partition (select products only) on page 123.

Recovering using HP Recovery Manager

HP Recovery Manager software allows you to recover the computer to its original factory state by using the 
HP Recovery media that you either created or that you obtained from HP, or by using the HP Recovery 
partition (select products only). If you have not already created recovery media, see Creating HP Recovery 
media (select products only) on page 119.

What you need to know before you get started

● HP Recovery Manager recovers only software that was installed at the factory. For software not provided 
with this computer, you must either download the software from the manufacturer's website or reinstall 
the software from the media provided by the manufacturer.

Backing up, restoring, and recovering in Windows 10 121



IMPORTANT: Recovery through HP Recovery Manager should be used as a final attempt to correct 
computer issues.

● HP Recovery media must be used if the computer hard drive fails. If you have not already created 
recovery media, see Creating HP Recovery media (select products only) on page 119.

● To use the Factory Reset option (select products only), you must use HP Recovery media. If you have not 
already created recovery media, see Creating HP Recovery media (select products only) on page 119.

● If your computer does not allow the creation of HP Recovery media or if the HP Recovery media does not 
work, you can obtain recovery media for your system from support. See the Worldwide Telephone 
Numbers booklet included with the computer. You can also find contact information from the HP 
website. Go to http://www.hp.com/support, select your country or region, and follow the on-screen 
instructions.

IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data. Before 
beginning recovery, back up any personal data you want to retain.

Using HP Recovery media, you can choose from one of the following recovery options:

NOTE: Only the options available for your computer display when you start the recovery process.

● System Recovery—Reinstalls the original operating system, and then configures the settings for the 
programs that were installed at the factory.

● Factory Reset—Restores the computer to its original factory state by deleting all information from the 
hard drive and re-creating the partitions. Then it reinstalls the operating system and the software that 
was installed at the factory.

The HP Recovery partition (select products only) allows System Recovery only.

Using the HP Recovery partition (select products only)

The HP Recovery partition allows you to perform a system recovery without the need for recovery discs or a 
recovery USB flash drive. This type of recovery can be used only if the hard drive is still working.

To start HP Recovery Manager from the HP Recovery partition:

1. Type recovery in the taskbar search box, select Recovery Manager, and then select HP Recovery 
Environment.

- or -

Press f11 while the computer boots, or press and hold f11 as you press the power button.

2. Select Troubleshoot from the boot options menu.

3. Select Recovery Manager, and then follow the on-screen instructions.

Using HP Recovery media to recover

You can use HP Recovery media to recover the original system. This method can be used if your system does 
not have an HP Recovery partition or if the hard drive is not working properly.

1. If possible, back up all personal files.

2. Insert the HP Recovery media, and then restart the computer.

NOTE: If the computer does not automatically restart in HP Recovery Manager, change the computer 
boot order. See Changing the computer boot order on page 123.

3. Follow the on-screen instructions.
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Changing the computer boot order

If your computer does not restart in HP Recovery Manager, you can change the computer boot order, which is 
the order of devices listed in BIOS where the computer looks for startup information. You can change the 
selection to an optical drive or a USB flash drive.

To change the boot order:

1. Insert the HP Recovery media.

2. Access BIOS.

Restart the computer, quickly press esc, and then press f9 for boot options.

3. Select the optical drive or USB flash drive from which you want to boot.

4. Follow the on-screen instructions.

Removing the HP Recovery partition (select products only)

HP Recovery Manager software allows you to remove the HP Recovery partition to free up hard drive space.

IMPORTANT: After you remove the HP Recovery partition, you will not be able to perform System Recovery 
or create HP recovery media from the HP Recovery partition. So before you remove the Recovery partition, 
create HP Recovery media; see Creating HP Recovery media (select products only) on page 119.

NOTE: The Remove Recovery Partition option is only available on products that support this function.

Follow these steps to remove the HP Recovery partition:

1. Type recovery in the taskbar search box, and then select HP Recovery Manager.

2. Select Remove Recovery Partition, and then follow the on-screen instructions.

Backing up, restoring, and recovering in Windows 8.1 or 
Windows 8

Your computer includes tools provided by HP and Windows to help you safeguard your information 
and retrieve it if you ever need to. These tools will help you return your computer to a proper working state or 
even back to the original factory state, all with simple steps.

This section provides information about the following processes:

● Creating recovery media and backups

● Restoring and recovering your system

NOTE: This section describes an overview of backing up, restoring, and recovering options. For more details 
about the tools provided, see Help and Support. From the Start screen, type help, and then select Help and 
Support. 

Creating recovery media and backups

Recovery after a system failure is only as good as your most recent backup.
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1. After you successfully set up the computer, create recovery media. This step creates a backup of the 
recovery partition on the computer. The backup can be used to reinstall the original operating system in 
cases where the hard drive is corrupted or has been replaced.

You will use a USB flash drive to create a bootable recovery drive that can be used to troubleshoot a 
computer that is unable to start. The USB flash drive can be used to reinstall the original operating 
system and the programs that were installed at the factory.

NOTE: Any information on the USB flash drive will be erased before the recovery media is created.

● To create the Windows 8.1 recovery media, from the Start screen, type recovery drive, then 
click on Create a recovery drive. Follow the on-screen instructions to continue.

● To create the Windows 8 recovery media, from the Start screen, type recovery drive, and 
then click on Settings, then click on Create a recovery drive. Follow the on-screen instructions to 
continue.

2. Use the Windows tools to create system restore points and create backups of personal information. For 
more information and steps, see Help and Support. From the Start screen, type help, and then select 
Help and Support.

Restoring and recovering using Windows tools 

Windows offers several options for restoring from backup, refreshing the computer, and resetting the 
computer to its original state. For more information and steps, see Help and Support. From the Start screen, 
type help, and then select Help and Support.

Using Reset when the system is not responding

NOTE: You may be prompted by User Account Control for your permission or password when you perform 
certain tasks. To continue a task, select the appropriate option. For information about User Account Control, 
see Help and Support. From the Start screen, type help, and then select Help and Support.

IMPORTANT: Reset does not provide backups of your information. Before using Reset, back up any personal 
information you wish to retain.

If Windows recovery steps are not working and the system is not responding, use these steps to start Reset:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition:

● For Windows 8.1, from the Start screen, type pc, and then select This PC.

● For Windows 8, from the Start screen, type c, and then select Computer.

NOTE: If the HP Recovery partition is not listed, or you cannot check for its presence, you must recover 
using the recovery media you created; see Recovery using the Windows recovery USB flash drive 
on page 125. Or you must use the Windows operating system media and the Driver Recovery media 
(purchased separately); see Recovery using Windows operating system media (purchased separately) 
on page 125.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the HP logo is 
displayed. The computer Startup Menu displays.

4. Press f11 to select the System Recovery option.

5. Choose your keyboard layout.

6. Select Troubleshoot.
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7. Select Reset.

8. Follow the on-screen instructions to continue.

Recovery using the Windows recovery USB flash drive

To recover your system using the recovery USB flash drive you previously created:

NOTE: If you did not create a recovery USB flash drive or the one you created does not work, see Recovery 
using Windows operating system media (purchased separately) on page 125.

1. If possible, back up all personal files.

2. Insert the recovery USB flash drive you created into a USB port on your computer.

3. Restart the computer and as soon as you see the HP logo screen, press f9 to display a list of boot 
devices. Use the arrow keys to select your USB flash drive from the UEFI Boot Sources list. Press Enter to 
boot from that device.

4. Choose your keyboard layout.

5. Select Troubleshoot.

6. Select Refresh your PC.

7. Follow the on-screen instructions.

Recovery using Windows operating system media (purchased separately)

To order a Windows operating system DVD, contact support. Go to http://www.hp.com/support, select your 
country or region, and follow the on-screen instructions.

CAUTION: Using Windows operating system media completely erases the hard drive contents and reformats 
the hard drive. All files that you have created and any software that you have installed on the computer are 
permanently removed. When reformatting is complete, the recovery process helps you restore the operating 
system, as well as drivers, software, and utilities.

To initiate recovery using Windows operating system media:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then follow the instructions provided with the Windows operating system 
media to install the operating system.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the repair is completed and the Windows desktop appears:

1. Remove the Windows operating system media, and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Backing up, restoring, and recovering in Windows 7
Your computer includes tools provided by HP and Windows to help you safeguard your information 
and retrieve it if you ever need to. These tools will help you return your computer to a proper working state or 
even back to the original factory state, all with simple steps.
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This section provides information about the following processes:

● Creating recovery media and backups

● Restoring and recovering your system

NOTE: This section describes an overview of backing up, restoring, and recovering options. For more details 
about the Windows Backup and Restore tools provided, see Help and Support. To access Help and Support, 
select Start > Help and Support.

Recovery after a system failure is only as good as your most recent backup.

1. After you successfully set up the computer, create recovery media. This media can be used to reinstall 
the original operating system in cases where the hard drive is corrupted or has been replaced. See 
Creating recovery media on page 126.

2. As you add hardware and software programs, create system restore points. A system restore point is a 
snapshot of certain hard drive contents saved by Windows System Restore at a specific time. A system 
restore point contains information that Windows uses, such as registry settings. Windows creates a 
system restore point for you automatically during a Windows update and during other system 
maintenance (such as a software update, security scanning, or system diagnostics). You can also 
manually create a system restore point at any time. For more information and steps for creating specific 
system restore points, see Help and Support. To access Help and Support, select Start > Help and 
Support.

3. As you add photos, video, music, and other personal files, create a backup of your personal information. 
If files are accidentally deleted from the hard drive and they can no longer be restored from the Recycle 
Bin, or if files become corrupted, you can restore the files that you backed up. In case of system failure, 
you can use the backup files to restore the contents of your computer. See Backing up your information 
on page 128.

NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of 
system instability.

Creating recovery media

After you successfully set up the computer, create recovery media. The media can be used to reinstall the 
original operating system in cases where the hard drive is corrupted or has been replaced.

There are two types of recovery media. To determine which steps to follow for your computer:

1. Click the Start button.

2. Click All Programs.

● If Security and Protection is listed, continue with the steps in Creating recovery media using HP 
Recovery Manager (select models only) on page 126.

● If Productivity and Tools is listed, continue with the steps in Creating recovery discs with HP 
Recovery Disc Creator (select models only) on page 127.

Creating recovery media using HP Recovery Manager (select models only)

● To create recovery discs, your computer must have a DVD writer. Use DVD+R or DVD-R discs (purchased 
separately). The discs you use will depend on the type of optical drive you are using.

NOTE: DVD+R DL, DVD-R DL, or DVD±RW disc are not supported.

● You have the option of creating a recovery USB flash drive instead, using a high-quality USB drive.
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● If you are creating recovery discs, be sure to use high-quality discs. It is normal for the system to reject 
defective discs. You will be prompted to insert a new blank disc to try again.

● The number of discs in the recovery-disc set depends on your computer model (typically 3 to 6 DVDs). 
The Recovery Media Creation program tells you the specific number of blank discs needed to make the 
set. If you are using a USB flash drive, the program will tell you the size of the drive required to store all 
the data (minimum of 8 GB).

NOTE: The process of creating recovery media is lengthy. You can quit the process at any time. The 
next time you initiate the process, it resumes where it left off.

NOTE: Do not use media cards for creating recovery media. The system may not be able to boot up from a 
media card and you may not be able to run system recovery.

To create recovery discs:

1. Close all open programs.

2. Click the Start button, click All Programs, click Security and Protection, click Recovery Manager, and 
then click HP Recovery Media Creation. If prompted, click Yes to allow the program to continue.

3. Click Create recovery media using blank DVD(s), and then click Next.

4. Follow the on-screen instructions. Label each disc after you make it (for example, Recovery 1, Recovery 
2), and then store the discs in a secure place.

To create a recovery USB flash drive:

NOTE: You must use a USB flash drive with a capacity of at least 8 GB.

NOTE: Recovery Media Creation formats the USB flash drive, deleting any files on it.

1. Close all open programs.

2. Insert the USB flash drive into a USB port on the computer.

3. Click the Start button, click All Programs, click Security and Protection, click Recovery Manager, and 
then click Recovery Media Creation.

4. Click Create recovery media with a USB flash drive, and then click Next.

5. Select the USB flash drive from the list of media. The program will let you know how much storage is 
required to create the recovery drive. If the USB flash drive does not have enough storage capacity, it will 
appear grayed out, and you must replace it with a larger USB flash drive. Click Next.

6. Follow the on-screen instructions. When the process is complete, label the USB flash drive and store it in 
a secure place.

Creating recovery discs with HP Recovery Disc Creator (select models only)

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery discs on 
select models. After you successfully set up the computer, you can create recovery discs using HP Recovery 
Disc Creator. The recovery discs allow you to reinstall your original operating system as well as select drivers 
and applications if the hard drive becomes corrupted. HP Recovery Disc Creator creates two kinds of recovery 
discs:

● Windows 7 operating system DVD—Installs the operating system without additional drivers or 
applications.

● Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP 
Software Setup utility installs drivers and applications.
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To create recovery discs, your computer must have a DVD writer. Use any of the following types of discs 
(purchased separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on 
the type of optical drive you are using.

Creating recovery discs

NOTE: The Windows 7 operating system DVD can be created only once. The option to create that media will 
not be available after you create a Windows DVD.

To create the Windows DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Windows disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Create button to start the burning process. Label the disc after you create it, and store it in a 
secure place.

After the Windows 7 operating system DVD has been created, create the Driver Recovery DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Driver disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Create button to start the burning process. Label the disc after you create it, and store it in a 
secure place.

Backing up your information

You should create your initial backup immediately after initial system setup. As you add new software and 
data files, you should continue to back up your system on a regular basis to maintain a reasonably current 
backup. Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated directories.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your 
settings. The screen shot can be a time-saver if you have to reset your preferences.

● When backing up to discs, number each disc after removing it from the drive.

NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in 
Help and Support. To access Help and Support, select Start > Help and Support.

NOTE: You may be prompted by User Account Control for your permission or password when you perform 
certain tasks. To continue a task, select the appropriate option. For information about User Account Control, 
see Help and Support: Select Start > Help and Support.

To create a backup using Windows Backup and Restore: 

NOTE: The backup process may take over an hour, depending on file size and the speed of the computer.
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1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup.

System Restore

If you have a problem that might be due to software that you installed on your computer, or if you want to 
restore the system to a previous state without losing any personal information, use System Restore to return 
the computer to a previous restore point.

NOTE: Always use this System Restore procedure before you use the System Recovery feature.

To start System Restore:

1. Close all open programs.

2. Click the Start button, right-click Computer, and then click Properties.

3. Click System protection, System Restore, click Next, and then follow the on-screen instructions.

System Recovery

WARNING! This procedure will delete all user information. To prevent loss of information, be sure to back up 
all user information so you can restore it after recovery.

System Recovery completely erases and reformats the hard disk drive, deleting all data files that you have 
created, and then reinstalls the operating system, programs, and drivers. However, you must reinstall any 
software that was not installed on the computer at the factory. This includes software that came on media 
included in the computer accessory box, and any software programs you installed after purchase. Any 
personal files must be restored from backups you made.

If you were not able to create system recovery DVDs or USB flash drive, you can order a recovery disc set from 
support. Go to http://www.hp.com/support, select your country or region, and follow the on-screen 
instructions.

NOTE: Always use the System Restore procedure before you use the System Recovery program. See System 
Restore on page 129.

You must choose one of the following methods to perform a System Recovery:

● Recovery image — Run System Recovery from a recovery image stored on your hard disk drive. The 
recovery image is a file that contains a copy of the original factory-shipped software. To perform a 
System Recovery from a recovery image, see System Recovery when Windows is responding 
on page 129 or System Recovery when Windows is not responding on page 130.

● Recovery media — Run System Recovery from recovery media that you have created from files stored 
on your hard disk drive or purchased separately. See System Recovery using recovery media (select 
models only) on page 130.

System Recovery when Windows is responding

CAUTION: System Recovery deletes all data and programs you created or installed. Before you begin, back 
up any important data to a CD or DVD or to a USB flash drive.

NOTE: In some cases, you must use recovery media for this procedure. If you have not already created this 
media, follow the instructions in Creating recovery media on page 126.

If the computer is working and Windows 7 is responding, use these steps to perform a System Recovery:
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1. Turn off the computer.

2. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

3. Turn on the computer.

4. When Windows has loaded, click the Start button, and then click All Programs.

● If Security and Protection is listed, continue with step 5.

● If Productivity and Tools is listed, follow the steps in System Recovery when Windows is not 
responding on page 130.

5. Click Security and Protection, click Recovery Manager, and then click Recovery Manager. If prompted, 
click Yes to allow the program to continue.

6. Under I need help immediately, click System Recovery.

7. Select Yes, and then click Next. Your computer restarts.

8. When the computer restarts, you will see the Recovery Manager welcome screen again. Under I need 
help immediately, click System Recovery. If you are prompted to back up your files, and you have not 
done so, select Back up your files first (recommended), and then click Next. Otherwise, select Recover 
without backing up your files, and then click Next.

9. System Recovery begins. After System Recovery is complete, click Finish to restart the computer.

10. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then turn the 
computer back on.

System Recovery when Windows is not responding

CAUTION: System Recovery deletes all data and programs you created or installed.

If Windows is not responding, but the computer is working, follow these steps to perform a System Recovery.

1. Turn off the computer. If necessary, press and hold the power button until the computer turns off.

2. Disconnect all peripheral devices from the computer, except the monitor, keyboard, and mouse.

3. Press the power button to turn on the computer.

4. As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the Windows 
is Loading Files… message appears on the screen.

5. At the HP Recovery Manager screen, follow the on-screen instructions to continue.

6. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then turn the 
computer back on.

System Recovery using recovery media (select models only)

Use the steps provided in this section if you created recovery media using Creating recovery media using HP 
Recovery Manager (select models only) on page 126. If you used HP Recovery Disc Creator to create a 
Windows 7 operating system DVD and a Driver Recovery DVD, use the steps in Using HP Recovery Disc 
operating system discs (select models only) on page 131.

CAUTION: System Recovery deletes all data and programs you have created or installed. Back up any 
important data to a CD or DVD or to a USB flash drive.

To perform a System Recovery using recovery media:
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1. If you are using a set of DVDs, insert the first recovery disc into the DVD drive tray, and close the tray. If 
you are using a recovery USB flash drive, insert it into a USB port.

2. Click the Start button, and then click Shut Down.

or

If the computer is not responding, press and hold the power button for approximately 5 seconds or until 
the computer turns off.

3. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

4. Press the power button to turn on the computer, and press Esc as the computer is powering on to 
display the startup menu.

5. Use the arrow keys to select the boot menu, and press Enter. Use the arrow keys to select the location 
where the recovery media is inserted (USB or DVD). Press Enter to boot from that device.

6. If Recovery Manager asks if you want to run System Recovery from Media or Hard Drive, select Media. On 
the Welcome screen, under I need help immediately, click Factory Reset.

7. If you are prompted to back up your files, and you have not done so, select Back up your files first 
(recommended), and then click Next. Otherwise, select Recover without backing up your files, and 
then click Next.

8. If you are prompted to insert the next recovery disc, do so.

9. When Recovery Manager is finished, remove the recovery disc or the recovery USB flash drive from the 
system.

10. Click Finish to restart the computer.

Using HP Recovery Disc operating system discs (select models only)

Use the steps provided in this section if you used HP Recovery Disc Creator to create a Windows 7 operating 
system DVD and a Driver Recovery DVD. If you created recovery media using Creating recovery media using HP 
Recovery Manager (select models only) on page 126. use the steps in System Recovery using recovery media 
(select models only) on page 130.

If you cannot use the recovery discs you previously created using the HP Recovery Disc Creator (select models 
only), you must purchase a Windows 7 operating system DVD to reboot the computer and repair the operating 
system.

To order a Windows 7 operating system DVD, contact support. Go to http://www.hp.com/support, select your 
country or region, and follow the on-screen instructions.

CAUTION: Using a Windows 7 operating system DVD completely erases the hard drive contents and 
reformats the hard drive. All files that you have created and any software that you have installed on the 
computer are permanently removed. When reformatting is complete, the recovery process helps you restore 
the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

NOTE: This process takes several minutes.
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1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive before 
the Windows operating system loads.

NOTE: If the computer does not boot to the DVD, restart the computer and press Esc as the computer 
is powering on to see the startup menu. Use the arrow keys to select the boot menu and press Enter. Use 
the arrow keys to select the location where the recovery DVD is inserted. Press Enter to boot from that 
device.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Install now.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD and then insert the Driver Recovery DVD.

2. Follow the on-screen instructions to install the Hardware Enabling Drivers first, and then install 
Recommended Applications.
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A Battery replacement

The battery installed on the computer provides power to the real-time clock. When replacing the battery, use 
a battery equivalent to the battery originally installed on the computer. The computer has a 3-volt lithium 
coin cell battery installed.

WARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of fire and 
burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 60°C (140ºF).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

Replace the battery only with the HP spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When the 
battery is removed or replaced, the CMOS settings will be cleared.

Static electricity can damage the electronic components of the computer or optional equipment. Before 
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a 
grounded metal object.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall 
socket. The lithium battery is only used when the computer is NOT connected to AC power.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable 
batteries. For more information about recycling programs, go to http://www.hp.com/recycle.

1. Remove/disengage any security devices that prohibit opening the computer.

2. Remove all removable media, such as compact discs or USB flash drives, from the computer.

3. Turn off the computer properly through the operating system, then turn off any external devices.

4. Disconnect the power cord from the power outlet and disconnect any external devices.

CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as 
the system is plugged into an active AC outlet. You must disconnect the power cord to avoid damage to 
the internal components of the computer.

5. Remove the computer access panel.

6. Locate the battery and battery holder on the system board.

NOTE: On some computer models, it may be necessary to remove an internal component to gain 
access to the battery.

7. Depending on the type of battery holder on the system board, complete the following instructions to 
replace the battery.

Type 1

a. Lift the battery out of its holder.
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b. Slide the replacement battery into position, positive side up. The battery holder automatically 
secures the battery in the proper position.

Type 2

a. To release the battery from its holder, squeeze the metal clamp that extends above one edge of 
the battery. When the battery pops up, lift it out (1).

b. To insert the new battery, slide one edge of the replacement battery under the lip of the holder 
with the positive side up. Push the other edge down until the clamp snaps over the other edge of 
the battery (2).

Type 3

a. Pull back on the clip (1) that is holding the battery in place, and remove the battery (2).
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b. Insert the new battery and position the clip back into place.

NOTE: After the battery has been replaced, use the following steps to complete this procedure.

8. Replace the computer access panel.

9. Plug in the computer and turn on power to the computer.

10. Reset the date and time, your passwords, and any special system setups using Computer Setup.

11. Lock any security devices that were disengaged when the computer access panel was removed.
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B Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch feature on 
the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC. Power 
supplies on those computers that do not have external power switches are equipped with internal switches 
that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where you 
purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use the 
computer.

General Requirements
The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for evaluation in the 
country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal voltage 
rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord must be 
between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed upon it or 
against it. Particular attention should be paid to the plug, electrical outlet, and the point where the cord exits 
from the product.

WARNING! Do not operate this product with a damaged power cord set. If the power cord set is damaged in 
any manner, replace it immediately.

Japanese Power Cord Requirements
For use in Japan, use only the power cord received with this product.

CAUTION: Do not use the power cord received with this product on any other products.
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Country-Specific Requirements
Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency  Country Accrediting Agency

Australia (1)

Austria (1)

Belgium (1)

Canada (2)

EANSW

OVE

CEBC

CSA

 Italy (1)

Japan (3)

Norway (1)

Sweden (1)

IMQ

METI

NEMKO

SEMKO

Denmark (1)

Finland (1)

France (1)

Germany (1)

DEMKO

SETI

UTE

VDE

 Switzerland (1)

United Kingdom (1)

United States (2)

SEV

BSI

UL

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance coupler and 
wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type 
with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese 
Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug must be a two-pole 
grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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C Statement of Volatility

HP confirms that AMD-based business desktop HP EliteDesk 705 G1 Microtower and Small Form Factor 
systems contain DDR3 volatile memory (memory amount depends on the customer configuration). In 
addition, the motherboard in the condition originally shipped without subsequent modification or the addition 
or installation of any applications, features, or functionality, contain the following nonvolatile memory: Real 
Time Clock battery backed-up configuration memory (256 Bytes), DIMM Serial Presence Detect (SPD) 
configuration data (256 Bytes per module, 128 Bytes programmable), Serial Peripheral Interface (SPI) ROM 
for System BIOS (8M Bytes) and Super I/O’s: masked keyboard ROM (overall 2K Bytes). In addition, these units 
contain a Trusted Platform Module (TPM) that contains 16K Bytes of non-volatile memory for user data. The 
volatile memory will not hold any user data once power has been removed for 30 seconds or longer.

The following procedure shows the steps that should be taken to restore the Non-Volatile memory found in 
the Intel-based HP ProDesk 705 G1 systems:

1. Download the latest BIOS (system ROM) from the HP website.

2. Follow the instructions to flash the BIOS that are found on the website.

Flashing the BIOS will reset it back to factory settings.

3. Turn on the system, and while system is powering on, and after the HP splash screen, press the F10 key 
to enter BIOS setup screen.

4. Select Security > System Security from the main menu. If the Embedded Security Device Support 
option is set to “Disable”, skip to step 7.

5. To erase all security keys from the TPM:

Under Embedded Security Device in the System Security menu, configure Reset to Factory Settings to 
Reset.

NOTE: Although the TPM security keys will be cleared, data in the non-volatile memory indices may 
not be. Data stored in these indices should not contain security sensitive information. If an application 
locks down and secures the non-volatile indices, these indices cannot be cleared.

6. Press F10 to accept changes.

7. To clear the secure boot key database:

a. Enter the F10 setup utility.

b. Go to the Security menu.

c. Select Secure Boot Configuration.

d. In the Key Management section, select clear Secure boot keys.

e. Use space key to select clear.

f. Press the F10 key to accept changes.

g. From the main menu select File > Save Changes and Exit.

8. If the Ownership Tag or Asset Tag is set, manually clear it under Security > System Ids.

9. Select File > Save Changes and Exit.
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10. To clear the Setup or Power-On passwords if set, and clear any other settings, power down the computer 
and remove the AC power cord and the computer hood.

11. Locate the green two pin password jumper on header E49 (labeled PSWD) and remove it.

12. Remove the AC power, wait 10 seconds until the unit AC power has drained out, then press the clear 
CMOS button. This is typically a yellow push button (labeled CMOS).

13. Replace the hood and AC power cord and turn the computer on. The passwords are now cleared and all 
other user-configurable, non-volatile memory settings are reset to their factory default values.

14. Enter the F10 setup utility.

15. Select File > Default Setup > Restore Factory Settings as Default. This will set the default settings 
back to the factory defaults.

16. Select File > Apply Defaults and Exit.

17. Shut down the computer, remove the AC power cord and place the (blue/green) jumper back on header 
E49. Replace the computer hood and power cord.

If Computrace is enabled on the computer, see the service provider for instruction to disable the feature.
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D Specifications

SFF Specifications
Table D-1  Specifications

Chassis (in the desktop position)

Height

Width

Depth

3.95 in

13.3 in

14.9 in

10.0 mm

338 mm

380 mm

Approximate Weight 16.7 lb 7.6 kg

Weight Supported (maximum distributed load in desktop position) 77 lb 35 kg

Temperature Range

Operating

Nonoperating

50° to 95°F

-22° to 140°F

10° to 35°C

-30° to 60°C

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no direct sustained 
sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and number of options installed.

Relative Humidity (noncondensing)

Operating

Nonoperating (38.7°C max wet bulb)

10-90%

5-95%

10-90%

5-95%

Maximum Altitude (unpressurized)

Operating

Nonoperating

10,000 ft

30,000 ft

3048 m

9144 m

Power Supply

Operating Voltage Range

Rated Voltage Range

Rated Line Frequency

Operating Line Frequency

90-264 VAC

100-240 VAC

50-60 Hz

47-63 Hz

Standard Efficiency 200W active PFC

80 PLUS Bronze 200W active PFC; 82/85/82% efficient at 20/50/100% 
load (115V)

80 PLUS Platinum 200W active PFC; 90/92/89% efficient at 20/50/100% 
load (115V)

200W active PFC; 91/93/90% efficient at 20/50/100% 
load (230V)

Rated Input Current 3.5A/Max

Current Leakage (NFPA 99) < 275 μA
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